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 Safety Guidelines 
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 
Danger 

indicates that death or severe personal injury will result if proper precautions are not taken. 

 
Warning 

indicates that death or severe personal injury may result if proper precautions are not taken. 

 
Caution 

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

 Caution 

without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

 Notice 

indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The device/system may only be set up and used in conjunction with this documentation. Commissioning and 
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes 
in this documentation qualified persons are defined as persons who are authorized to commission, ground and 
label devices, systems and circuits in accordance with established safety practices and standards. 

Prescribed Usage 
Note the following: 

 
Warning 

This device may only be used for the applications described in the catalog or the technical description and only in 
connection with devices or components from other manufacturers which have been approved or recommended by 
Siemens. Correct, reliable operation of the product requires proper transport, storage, positioning and assembly 
as well as careful operation and maintenance. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Foreword 

SINUMERIK documentation 
The SINUMERIK documentation is organized in 3 parts: 
• General Documentation 
• User Documentation 
• Manufacturer/service documentation 
A list of documents, updated on a monthly basis, is available on the Internet for the available 
languages at: 
http://www.siemens.com/motioncontrol 
Select "Support"/"Technical Documentation"/"Overview of Documents". 
The Internet version of the DOConCD (DOConWEB) is available at: 
http://www.automation.siemens.com/doconweb 
You can find information on the training courses offered and FAQs (frequently asked 
questions) on the Internet under: 
http://www.siemens.com/motioncontrol (under "Support") 

Target group 
This manual is intended for use by planners, configuration engineers, technicians, 
installation personnel, programmers, commissioning personnel, operators, service and 
maintenance personnel 

Benefits 
The operating instructions impart knowledge about the components and allow the addressed 
target groups to properly and safely install, set up, test and commission the SINUMERIK 
802D sl. 

Standard scope 
This documentation only describes the functionality of the standard version. Additions or 
revisions made by the machine tool manufacturer are documented by the machine tool 
manufacturer. 
Other functions not described in this documentation might be executable in the control. 
However, no claim can be made regarding the availability of these functions when the 
equipment is first supplied or in the event of servicing. 
For the sake of simplicity, this documentation does not contain all detailed information about 
all types of the product and cannot cover every conceivable case of installation, operation, or 
maintenance. 
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Technical support 
In case of questions, please contact us through the following hotline: 

Table 1 Europe and Africa time zone 

A&D Technical Support 
Phone: +49 (0) 180 / 5050 - 222 
Fax: +49 (0) 180 / 5050 - 223 
Internet: http://www.siemens.com/automation/support-request 
E-mail: mailto:adsupport@siemens.com 

 

Table 2 Asia and Australia time zone 

A&D Technical Support 
Phone: +86 1064 719 990 
Fax: +86 1064 747 474 
Internet: http://www.siemens.com/automation/support-request 
E-mail: mailto:adsupport@siemens.com 

 

Table 3 American time zone 

A&D Technical Support 
Phone: +1 423 262 2522 
Fax: +1 423 262 2289 
Internet: http://www.siemens.com/automation/support-request 
E-mail: mailto:adsupport@siemens.com 

 

Questions about the Manual 
If you have any queries (suggestions, corrections) in relation to this documentation, please 
fax or e-mail us: 

 
Fax: +49 (0) 9131 / 98 63315 
E-mail: mailto:adsupport@siemens.com 
Fax form: See the reply form at the end of this publication 

 

SINUMERIK Internet address 
http://www.siemens.com/sinumerik 
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EC declaration of conformity 
The EC Declaration of Conformity for the EMC Directive can be found/obtained  
• on the Internet: 

http://www.ad.siemens.de/csinfo 
under product/Order No. 15257461 

• at the relevant regional office of the A&D MC Group of Siemens AG. 

Further notes 
 

 Note 
This symbol always appears in the document where further information is provided. 

 

Licensing provisions 
The software SINUMERIK 802D sl is protected by national and international copyright laws 
and agreements. Unauthorized reproduction and distribution of this software or parts thereof 
is liable to prosecution. It will be prosecuted both according to criminal and civil law and may 
result in severe punishment or demands for compensation. 
In the software SINUMERIK 802D sl, open source software is used. The licensing provisions 
for this software are located on the Toolbox CD and are to be observed accordingly. 

Acceptance report 
You can find a sample report for the acceptance of SINUMERIK 802D sl on the Internet at: 
http://support.automation.siemens.com under the heading Current > Acceptance reports 
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Description 1
1.1 System overview 

Overview 
The CNC operator panel of the SINUMERIK 802D sl control systems combines all CNC, 
PLC, HMI and communication tasks in one component. The maintenance-free hardware 
integrates the DRIVE-CLiQ interface for the drives and PROFIBUS interface for the I/O 
modules with the slimline operator panel into a ready-to-install unit (Panel Control Unit). 
The SINUMERIK 802D sl can control up to 6 axes digitally. At the most, up to 5 NC axes of 
these 6 axes and one PLC axis can be configured. Up to 2 of these 5 NC axes can be 
configured as a spindle. 
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Figure 1-1 SINUMERIK 802D sl with SINAMICS S120 (example configuration) 
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Figure 1-2 SINUMERIK 802D sl with MCPA module (example configuration) 
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Components 
The components of the SINUMERIK 802D sl control system are: 
• CNC operator panel (PCU) with CNC full keyboard (portrait or landscape format) 
• Machine control panel 

Incorporates all keys and switches required for the operation of a machine The machine 
control panel is available in 2 versions: 
– Machine control panel MCP to connect via a PP 72/48 I/O module 
– Machine control panel MCP 802D sl to connect via an MCPA module 

• MCPA module (hardware optional) 
The MCPA module is a supplemental/expansion module of the SINUMERIK 802D sl. It 
places the following resources at your disposal: 
– Analog output for ± 10 V (X701) for connecting an analog spindle 
– Interface for connecting an external machine control panel (X1, X2) 
– Interface for connecting inputs and outputs (1 bytes each) in the form of high-speed 

inputs/outputs. 
• PP72/48 I/O module 

The PP72/48 I/O module is a user-friendly and low-cost module (without a separate 
housing) within the framework of an automation system based on PROFIBUS DP for 
connecting digital inputs/outputs. 
The module has the following important features: 
– PROFIBUS DP connection (12 Mbits/s max.) 
– 72 digital inputs and 48 digital outputs 
– On-board status display via four diagnostic LEDs 
To supply the module and the digital outputs, an external voltage source (+24VDC) is 
required. 

• Drive units 
– SINAMICS S120 

The communication between the SINUMERIK 802D sl control system and the 
SINAMICS S120 drive is provided via the DRIVECLiQ communication system (Drive 
Component Link with IQ). 

System software 
The following system software is installed in the retentive internal memory of the PCU of 
each SINUMERIK 802D sl by default: 
• Boot software - starts the system 
• Human Machine Interface (HMI) software - realizes all operator functions 
• NCK software (NC Kernel) - realizes all NC functions. 
• Programmable Logic Control (PLC) software - executes the integrated PLC user program 

cyclically. 
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Toolbox 
A tool box is delivered on CD ROM together with the appropriate system software. 
The toolbox contains software tools for configuring the control system. It must be installed on 
your PC/PG. 
The following software can be found in the Toolbox: 
• Configuration data for the SINUMERIK 802D sl: 

– Setup file for the technologies 
– Cycle packages for the technologies 
– Reloadable languages 

• SIMATIC Automation License Manager 
The Automation License Manager is needed for managing license keys (e.g. for 
RCS802). 

• RCS802 Commissioning and diagnostic tool (must be licensed for Ethernet and remote 
control function) 
This program can be used to transfer texts, user data and programs from the PC to the 
CNC operator panel (PCU) and vice versa. 

• PLC 802 programming tool 
Tool to create PLC user program 

• PLC user library 
PLC sample programs 

• STARTER 
Parameterization and commissioning tool for the "SINAMICS" drive 

 

  Note 
The table of contents and notes for setup can be found in the siemense.txt file. 

 

1.2 Description of components 

View 
The illustration below shows the CNC operator panel (PCU) with its interfaces and the front 
panel elements. 
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Option interface
X110

 
Figure 1-3 Position of the interfaces and front elements on the CNC operator panel 

CNC operator panel (PCU) interfaces  
The PCU and its functions are described in the table below. 
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Table 1-1 PCU interfaces 

interfaces Function 
Compact flash card (CF card) slot  50-pin slot for CF cards, and 4 LEDs 
Power supply connection  
X40 

3-pin screw-type terminal connection for 
connecting the 24 V load power supply 

Ethernet interface 
X5 

8-pin RJ45 socket connector for connection to an 
Industrial Ethernet 

USB interface 
X10 

4-pin USB port for connecting USB accessories 
(available soon) 

NC full keyboard connection  
X9 

6-pin PS/2 socket for connecting the NC full 
keyboard 

RS232 COM interface 
X8 

9-pin DSub connector for connecting a PG/PC 

PROFIBUS DP interface 
X6 

9-pin DSub socket for connection to PROFIBUS 
DP 

DRIVE–CLiQ interface 
X1 and X2 

8-pin RJ45 socket for connecting the SINAMICS 
S120 drive 

Handwheel connection 
X30 

12-pin screw-type male connector for connecting 
a max. of 2 handwheels 

Digital inputs/digital outputs 
X20 and X21 

12-pin screw-type male connector for connecting 
the digital inputs and outputs 

Option interface 
X110 

48-pin female connector for connecting the 
MCPA module 
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interfaces 2
2.1 CNC operator panel interfaces 

2.1.1 Compact flash card (CF card) slot 
Only type 1 compact flash cards can be used.  
The compact flash card can be used, for example: 
• for start-up data 
• for NC programs 
• to carry out software updates 
• to store user data 
• to save parameters which have been set by the user.  

2.1.2 Ethernet interface 
A PG/PC can be connected to the Ethernet interface via a Industrial Ethernet network. The 
device connected must possess an Ethernet card and the appropriate software.  
Industrial Ethernet is a communication network providing a transmission rate of 10/100 
Mbps.  

Female connector pin assignment 
Identifiers: X5(IE) 
Type: 8-pin RJ45 socket 

Table 2-1 Pin assignment of female connector X5 

Schematic view of the female connector, 
mounting position and labeling 

Pin Name Description 

1 TXP Transmit data +  
2 TXN Transmit data -  
3 RXP Receive data +  
4 not assigned - 

 
 

 

 5 not assigned - 
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Schematic view of the female connector, 
mounting position and labeling 

Pin Name Description 

6 RXN Receive data -  
7 not assigned - 

 

 

 

8 not assigned - 

For additional information about the cabling options for Ethernet, contact your SIEMENS 
representative. 

 

2.1.3 USB port (available soon) 

2.1.4 RS232 COM port 
A PC / programming device (PG) for data exchange with the CNC operator panel can be 
connected to male connector X8.  

Connector pin assignment 
Identifiers: X8 (RS232) 
Type: 9-pin D–Sub terminal strip 

Table 2-2 Pin assignment of connector X8 

Schematic 
view of the 
female 
connector,  
mounting 
position and 
labeling 

Pin Name Description 
German/English: 

1 DCD Received Line Signal 
Detector Carrier Detector

Data carrier detect 

2 RxD Received Data Received data 
3 TxD Transmitted Data Transmitted data 
4 DTR Data Terminal Ready Data Terminal Ready 
5 G Ground Ground 
6 DSR Data Set Ready Data Set Ready 
7 RTS Request To Send Transmission request 

 
 

 

 
8 CTS Clear To Send Ready to send 



 interfaces 
 2.1 CNC operator panel interfaces 

Operating Instructions 
Operating Instructions, 12/2006, 6FC5397-0CP10-2BA0 23 

Schematic 
view of the 
female 
connector,  
mounting 
position and 
labeling 

Pin Name Description 
German/English: 

9 not assigned - - 

 

2.1.5 PROFIBUS DP interface 
The CNC operator panel (PCU) communicates with the I/O modules via the PROFIBUS DP 
interface.  
 
The PROFIBUS DP protocol is used for communications. 
The baud rate of the PROFIBUS DP interface is 12 Mbit/s; the baud rate cannot be changed. 
Converters for optical fiber cable (OLMs, OLPs) or repeaters are not permitted. 
The operator panel CNC provides master functionality. 

Female connector pin assignment 
Designation: X6 (DP1) 
Type: 9-pin D–Sub socket connector 

Table 2-3 Pin assignment of female connector X6 

Schematic view of the female 
connector,  
mounting position and labeling 

Pin Name Description 

1 not assigned  - 
2 M24  
3 B Data input/output (RS485) 
4 RTS Transmission request 
5 M5 5 V reference potential 
6 P5 5 V power supply 90 mA, short-circuit-

proof 
7 P24 24V power supply (teleservice) 150mA, 

short-circuit-proof, not isolated 
8 A Data input/output (RS485) 

 

9 not assigned - 
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2.1.6 DRIVE-CLiQ interface 
The CNC operator panel (PCU) can communicate with the "SINAMICS S" drive via the 
DRIVE CLiQ interface.  

Female connector pin assignment 
Designation: X1, X2 
Type: 8-pin RJ45 socket 

Table 2-4 Pin assignment of female connector X1 and X2 

Schematic view of the female connector,  
mounting position and labeling 

Pin Name Description 

1 TXP Transmit data +  
2 TXN Transmit data -  
3 RXP Receive data +  
4 not assigned - 
5 not assigned - 
6 RXN Receive data -  
7 not assigned - 
8 not assigned - 
A not assigned - 

 
 

 

 

B not assigned - 
Blanking plate for DRIVE CLiQ interface: Molex corp., order no. 85999–3255 

 

2.1.7 Handwheel connection 
Max. 2 electronic handwheels can be connected to connector X30 on the CNC operator 
panel (PCU).  
The handwheel must meet the following requirements: 

 
Transmission procedure: 5 V square wave signals (TTL level or RS422) 
Signals: Track A as a true and negated signal (Ua1, Ua1) 

Track B as a true and negated signal (Ua2, Ua2) 
Max. output frequency: 500 kHz 
Phase shift of Track A to Track B: 90° ±30° 
Supply: 5 V, max. 250 mA 

Connector pin assignment 
Designation: X30 
Type: 12-pin connector  



 interfaces 
 2.1 CNC operator panel interfaces 

Operating Instructions 
Operating Instructions, 12/2006, 6FC5397-0CP10-2BA0 25 

Table 2-5 Pin assignment of connector X30 

Schematic view of the connector Pin Name Description 
1 3P5 5VDC supply voltage 
2 G Ground 
3 1A Track A, handwheel 1 
4 X1A Track A_N, handwheel 1 
5 1B Track B, handwheel 1 
6 X1B Track B_N, handwheel 1 
7 3P5 5VDC supply voltage 
8 G Ground 
9 2A Track A, handwheel 2 
10 X2A Track A_N, handwheel 2 
11 2B Track B, handwheel 2 

 
 

 12 X2B Track B_N, handwheel 2 

 

2.1.8 Digital inputs/outputs 
You can implement the circuit of the SINAMICS drives via digital inputs and digital outputs at 
connectors X20 and X21. 
A maximum of 16 or 8 digital inputs and 8 digital outputs can be used.  
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Wiring and block diagrams 

 
Figure 2-1 Connection example 

 

Connector pin assignment 
Designation: X20, X21 
Type: 12-pin connector  
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Table 2-6 Pin assignment of the connectors X20 and X21 

Representati
on  

Pin Name Description Technical details 

1 DI0 Digital input 0 
2 DI1 Digital input 1 
3 DI2 Digital input 2 
4 DI3 Digital input 3 
5 M_3 Ground for DI0...DI3 

Input: 
Voltage: 24VDC (20.4 ... 28.8V) 
Level: 
0 signal: -3...5 V 
1 signal: 11...30 V 
Input delay: 
0 → 1 signal: 15 µs (typically 6) 
1 → 0 signal: 150 µs (typically 40) 

6 P24_1 24VDC Supply voltage for 
DI/DO0...DI/DO3 (required 
for digital outputs) 

7 DI/DO0 Digital I/O 
8 DI/DO1 Digital I/O 
9 M_1 Ground for 

DI/DO0...DI/DO3 
10 DI/DO2 Digital I/O 
11 DI/DO3 Digital I/O 

 

 

12 M_1 Ground for 
DI/DO0...DI/DO3 

For the output: 
max. output current: 
1 signal: 5 mA ... 0.5 A 
Total current of all outputs:  
max. 2 A (in case of simultaneous 
occurrence 50 %) 
Output delay: 
0 → 1 signal: 500 µs 
(typically 150 µs) 
1 → 0 signal: 500 µs 
(typ. 150 µs) 
each for RL = 60 Ohms 
switching frequency: 
100 Hz (ohmic load) 
2 Hz (inductive load) 
For the input: 
Data see connector X21 

 
1 DI4 Digital input 4 
2 DI5 Digital input 5 
3 DI6 Digital input 6 
4 DI7 Digital input 7 
5 M_4 Ground for DI4...DI7 

Input: 
for the data, see connector X20 

6 P24_2 24VDC supply voltage for 
DI/DO4...DI/DO7 (required 
for digital outputs) 

7 DI/DO4 Digital I/O 
8 DI/DO5 Digital I/O 
9 M_2 Ground for 

DI/DO4...DI/DO7 
10 DI/DO6 Digital I/O 
11 DI/DO7 Digital I/O 

 

 

12 M_2 Ground for 
DI/DO4...DI/DO7 

Output: 
for the data, see connector X20 
Input: 
Voltage: 24VDC (20.4 ... 28.8V) 
Level: 
0 signal: -3...5 V 
1 signal: 11...30 V 
Input delay: 
0 → 1 signal: 15 µs (typically 6) 
1 → 0 signal: 150 µs (typically 40) 
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Danger 
The 24 V power supply is to be designed as functional extra-low voltage with protective 
separation in accordance with EN60204–1, Section 6.4, PELV (with G ground). 

 

Digital inputs (PCU)  
These high-speed inputs correspond to Standard IEC 1131-2/DIN EN 61131-2, characteristic 
curve type 2 (24 V-P-switching). Switches or proximity encoders (2- or 3-wire encoders) can 
be connected. 

Digital outputs (PCU)  
These high-speed outputs (onboard) correspond to Standard IEC 1131-2/DIN EN 61131-2 
(24 V-P-switching).  

See also 
Setting the Profibus addresses (Page 90) 

2.2 MCPA module interfaces 

Overview 
The illustration below shows the MCPA module with its interfaces and the status display. 

 
Figure 2-2 Position of the interfaces and of the status display on the MCPA module 
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Table 2-7 Interfaces and status display 

interfaces Function 
Interface for  
MCP 802D sl 
X1 and X2 

40-pin plug connectors for connecting the machine control panel (MCP) 

I/O interface 
X1020 and X1021 

10-pin plug connectors for connection of the power supply and of the 
high-speed digital inputs and outputs 

Analog spindle connection
X701 

9-pin D-Sub connector for connecting an analog spindle with directly 
mounted spindle actual-value encoder 

Interface to the PCU 
X110 

48-pin plug connectors for connecting the MCPA module to the PCU 

Assignment of the interface to the MCP 802D sl 
Designation: X1, X2 
Type: 40-pin ribbon cable connector 

Table 2-8 Pin assignment of connectors X1 and X2 

X1 
Pin Name Description Pin Name Description 
1 KEY1 Input bit 2 KEY2 Input bit 
3 KEY3 Input bit 4 KEY4 Input bit 
5 KEY5 Input bit 6 KEY6 Input bit 
7 KEY7 Input bit 8 KEY8 Input bit 
9 GND  10 KEY9 Input bit 
11 KEY10 Input bit 12 KEY11 Input bit 
13 KEY12 Input bit 14 KEY13 Input bit 
15 KEY14 Input bit 16 KEY15 Input bit 
17 KEY16 Input bit 18 GND  
19 KEY17 Input bit 20 KEY18 Input bit 
21 KEY19 Input bit 22 KEY20 Input bit 
23 KEY21 Input bit 24 KEY22 Input bit 
25 KEY23 Input bit 26 KEY24 Input bit 
27 GND  28 LED1 Output bit 
29 LED2 Output bit 30 LED3 Output bit 
31 LED4 Output bit 32 LED5 Output bit 
33 LED6 Output bit 34 not assigned - 
35 not assigned - 36 GND  
37 not assigned - 38 not assigned - 
39 not assigned - 40 not assigned - 

 
 

X2 
1 KEY25 Input bit 2 KEY26 Input bit 
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X2 
3 KEY27 Input bit 4 not assigned - 
5 not assigned - 6 not assigned - 
7 not assigned - 8 not assigned - 
9 GND  10 FEED_OV_A Input bit 
11 FEED_OV_B Input bit 12 FEED_OV_C Input bit 
13 FEED_OV_D Input bit 14 FEED_OV_E Input bit 
15 not assigned - 16 not assigned - 
17 not assigned - 18 GND  
19 SPINDLE_OV_A Input bit 20 SPINDLE_OV_B Input bit 
21 SPINDLE_OV_C Input bit 22 SPINDLE_OV_D Input bit 
23 SPINDLE_OV_E Input bit 24 not assigned - 
25 not assigned - 26 not assigned - 
27 not assigned - 28 not assigned - 
29 not assigned - 30 not assigned - 
31 not assigned - 32 not assigned - 
33 not assigned - 34 not assigned - 
35 not assigned - 36 GND  
37 not assigned - 38 not assigned - 
39 not assigned - 40 not assigned - 

Assignment of the I/O interface connectors 
Designation: X1020, X1021 
Type: 10-pin connector  

Table 2-9 Pin assignment of the connectors X1020 and X1021 

Representation Pin Name Description 
1   
2 DI0 high-speed digital input 0 
3 DI1 high-speed digital input 1 
4 DI2 high-speed digital input 2 
5 DI3 high-speed digital input 3 
6 DI4 high-speed digital input 4 
7 DI5 high-speed digital input 5 
8 DI6 high-speed digital input 6 
9 DI7 high-speed digital input 7 

 
10  Chassis ground 

 
1 P24 24VDC supply voltage 
2 Q0 high-speed digital output 0 
3 Q1 high-speed digital output 1 
4 Q2 high-speed digital output 2 
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Representation Pin Name Description 
5 Q3 high-speed digital output 3 
6 Q4 high-speed digital output 4 
7 Q5 high-speed digital output 5 
8 Q6 high-speed digital output 6 
9 Q7 high-speed digital output 7 
10 G Ground 

Connector pin assignment (analog output to the drive)  
Designation: X701 
Type: 9-pin D–Sub terminal strip 

Table 2-10 Pin assignment of connector X701 

Schematic view of the female 
connector,  
mounting position and labeling

Pin Name Description 
German 

1 Analog OUT Analog output with a signal level of ±10 V 
Resolution 11 bits + sign 

2 not assigned - 
3 Uni-Dir2 Digital output for unipolar spindle +24 V 
4 Uni-Dir1 Digital output for unipolar spindle +24 V 
5 Enable 1- Analog drive enable (contact: electrically 

isolated n.o. contact) 
6 Analog OUT Analog output 0 V Reference signal 
7 not assigned - 
8 not assigned - 

 

9 Enable 2- Analog drive enable (contact: electrically 
isolated n.o. contact) 

 

2.3 Interfaces of the machine control panel MCP 802D sl 
The illustration below shows the back of the machine control panel MCP 802D sl with its 
interfaces. 
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Figure 2-3 Interfaces at the MCP 802D sl 

Table 2-11 Interfaces 

Interfaces Function 
Interface X1201 40-pin D-Sub connector for connecting the machine control panel to the 

MCPA module X1 
Interface X1202 40-pin D-Sub connector for connecting the machine control panel to the 

MCPA module X2 

Interface assignments 
Designation: X1201, X1202 
Type: 40-pin D-Sub connector 
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Table 2-12 Pin assignment of the connectors X1201 and X1202 

X1201 
Pin Name Description Pin Name Description 
1 KEY1 Input bit 2 KEY2 Input bit 
3 KEY3 Input bit 4 KEY4 Input bit 
5 KEY5 Input bit 6 KEY6 Input bit 
7 KEY7 Input bit 8 KEY8 Input bit 
9 GND  10 KEY9 Input bit 
11 KEY10 Input bit 12 KEY11 Input bit 
13 KEY12 Input bit 14 KEY13 Input bit 
15 KEY14 Input bit 16 KEY15 Input bit 
17 KEY16 Input bit 18 GND  
19 KEY17 Input bit 20 KEY18 Input bit 
21 KEY19 Input bit 22 KEY20 Input bit 
23 KEY21 Input bit 24 KEY22 Input bit 
25 KEY23 Input bit 26 KEY24 Input bit 
27 GND  28 LED1 Output bit 
29 LED2 Output bit 30 LED3 Output bit 
31 LED4 Output bit 32 LED5 Output bit 
33 LED6 Output bit 34 not assigned - 
35 not assigned - 36 GND  
37 not assigned - 38 not assigned - 
39 not assigned - 40 not assigned - 

 
 

X1202 
1 KEY25 Input bit 2 KEY26 Input bit 
3 KEY27 Input bit 4 not assigned - 
5 not assigned - 6 not assigned - 
7 not assigned - 8 not assigned - 
9 GND  10 FEED_OV_A Input bit 
11 FEED_OV_B Input bit 12 FEED_OV_C Input bit 
13 FEED_OV_D Input bit 14 FEED_OV_E Input bit 
15 not assigned - 16 not assigned - 
17 not assigned - 18 GND  
19 SPINDLE_OV_A Input bit 20 SPINDLE_OV_B Input bit 
21 SPINDLE_OV_C Input bit 22 SPINDLE_OV_D Input bit 
23 SPINDLE_OV_E Input bit 24 not assigned - 
25 not assigned - 26 not assigned - 
27 not assigned - 28 not assigned - 
29 not assigned - 30 not assigned - 
31 not assigned - 32 not assigned - 
33 not assigned - 34 not assigned - 
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X1202 
35 not assigned - 36 GND  
37 not assigned - 38 not assigned - 
39 not assigned - 40 not assigned - 

 

2.4 PP 72/48 I/O module interfaces 
The diagrams below show the interfaces, the operator controls and displays, as well as in 
the example the possibilities of connection to the I/O interface of the I/O module.  

 
Figure 2-4 Position of the interfaces and status displays on the I/O module with connection to the 

MCP and a terminal strip converter 
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Figure 2-5 Position of the interfaces and status displays on the I/O module when connecting 3 

terminal strip converters 

PP 72/48 interfaces 
The interfaces and the operator controls of the PP 72/48 I/O module and their functions are 
described in the table below.  

Table 2-13 Interfaces 

Interfaces Function 
PROFIBUS DP  
interface 

9-pin DSub socket X2 for connection to PROFIBUS DP 

Power supply  
connection 

3-pin screw-type terminal connection X1 for connecting the  
24 V load power supply 

I/O interface 50-pin plug connectors X111, X222, X333 for connecting the 
machine control panel or the terminal strip converters for the 
digital inputs/outputs 

DIL switch DIL switch S1 for setting the PROFIBUS DP address  

PROFIBUS DP interface X2 
The PROFIBUS DP protocol is used for communications. 
The baud rate of the PROFIBUS DP interface is 12 Mbps. 
The PP 72/48 I/O module provides slave functionality. 

Female connector pin assignment 
Designation: X2 
Type: 9-pin D–Sub socket connector 
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Table 2-14 Female connector X2 pin assignment 

Schematic view of the connector Pin Name Description 
1 not assigned  - 
2 not assigned  - 
3 B Data input/output (RS485) 
4 RTS Transmission request 
5 M5 5 V reference potential 
6 P5 5 V power supply 90 mA, short-

circuit-proof 
7 not assigned - 
8 A Data input/output (RS485) 

 

9 not assigned - 

I/O interface 
The following devices can be connected to the connectors X111, X222 and X333 (50-pin 
ribbon-cable plug): 
• either one machine control panel (MCP) and one terminal strip converter for digital 

inputs/digital outputs 
or 

• three terminal strip converter for digital inputs and digital outputs 
The terminal strip converters are connected to the PP 72/48 I/O module via ribbon cable. 
The individual wiring can be performed at the terminal strips according to your particular 
application. 

Connector pin assignment 
Designation: X111, X222, X333 
Type: 50-pin ribbon cable connector 

Table 2-15 Pin assignment of the connectors X111, X222, X333 

Pin Name Description Pin Name Description 
1 G Ground 2 P24OUTINT 24VDC, internal supply 

voltage for the inputs 
3 DI m+0.0 Input bit 4 DI m+0.1 Input bit 
5 DI m+0.2 Input bit 6 DI m+0.3 Input bit 
7 DI m+0.4 Input bit 8 DI m+0.5 Input bit 
9 DI m+0.6 Input bit 10 DI m+0.7 Input bit 
11 DI m+1.0 Input bit 12 DI m+1.1 Input bit 
13 DI m+1.2 Input bit 14 DI m+1.3 Input bit 
15 DI m+1.4 Input bit 16 DI m+1.5 Input bit 
17 DI m+1.6 Input bit 18 DI m+1.7 Input bit 
19 DI m+2.0 Input bit 20 DI m+2.1 Input bit 
21 DI m+2.2 Input bit 22 DI m+2.3 Input bit 
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Pin Name Description Pin Name Description 
23 DI m+2.4 Input bit 24 DI m+2.5 Input bit 
25 DI m+2.6 Input bit 26 DI m+2.7 Input bit 
27 not 

assigned 
- 28 not assigned - 

29 not 
assigned 

- 30 not assigned - 

31 DO n+0.0 Output bit 32 DO n+0.1 Output bit 
33 DO n+0.2 Output bit 34 DO n+0.3 Output bit 
35 DO n+0.4 Output bit 36 DO n+0.5 Output bit 
37 DO n+0.6 Output bit 38 DO n+0.7 Output bit 
39 DO n+1.0 Output bit 40 DO n+1.1 Output bit 
41 DO n+1.2 Output bit 42 DO n+1.3 Output bit 
43 DO n+1.4 Output bit 44 DO n+1.5 Output bit 
45 DO n+1.6 Output bit 46 DO n+1.7 Output bit 
47 DOCOMx1) 48 DOCOMx1) 
49 DOCOMx1) 

24VDC supply voltage for the 
outputs 50 DOCOMx1) 

24VDC supply voltage for the 
outputs 

1)x = 1 for connector X111; x = 2 for connector X222; x = 3 for connector X333 
 m = 0 for connector X111; m = 3 for connector X222; m = 6 for connector X333 
 n = 0 for connector X111; n = 2 for connector X222; n = 4 for connector X333 

 

 

 
Danger 
The 24 V power supply is to be designed as functional extra-low voltage with protective 
separation in accordance with EN60204–1, Section 6.4, PELV (with G ground). 

 

 

 Note 
The connection cable between the voltage source, the load current supply connector and the 
associated reference potential G should not exceed a maximum length of 10 m. 

 

Digital inputs 
The diagram below shows the connector pin assignment for the digital inputs at connection 
X111 (example). Connectors X222 and X333 are assigned analogously. 
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Figure 2-6 Terminal assignment for the digital inputs 

Internal power supply (P24OUTINT) 
The internal power supply for the digital inputs (X111, X222, X333: pin 2) is taken from the 
general power supply of module X1, pin 2 (P24).  

 

 
Caution 
Make sure that a max. current of Iout = 0.25 A at X111, X222, X333 on pin 2 is not exceeded. 
An exceeding of the maximum current might destroy the module. 

 

External power supply 
If an external power supply is used for the digital inputs, their reference ground must be 
connected to X111, X222, X333: Pin 1 (G). 
X111, X222, X333: Pin 1 (P24OUTINT) remains open. 
Digital outputs 
The diagram below shows the connector pin assignment for the digital outputs at connection 
X111 (example). Connectors X222 and X333 are assigned analogously. 
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Figure 2-7 Terminal assignment for the digital outputs 

To supply the digital outputs, an external 24VDC power supply must be connected to 
DOCOMx (X111, X222, X333: pins 47, 48, 49, 50). 
The reference ground of the external power supply source must be connected to X111, 
X222, X333: Pin 1 (G).  

 

 
Caution 
It is the user's responsibility to ensure that the max. current consumption per DOCOMx pin 
(X111, X222, X333: pins 47 through 50) does not exceed 1 A. 
It is imperative to connect the 24 V power supply for the digital outputs for DOCOMx to all 
four pins (X111, X222, X333: pins 47 through 50). 

 

 

 
Danger 
The 24 V power supply is to be designed as functional extra-low voltage with protective 
separation in accordance with EN60204-1, Section 6.4, PELV (with G ground). 
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2.5 Interfaces of the machine control panel MCP 
The illustration below shows the back of the machine control panel MCP with its interfaces. 

 

 
Figure 2-8 Interfaces on the MCP 

Table 2-16 Interfaces 

Interfaces Function 
Interface X1201 50-pin ribbon-cable plug for connecting the machine control panel to the 

PP module 
Interface X1202 50-pin ribbon-cable plug for connecting the machine control panel to the 

PP module 

Interface assignments 
Designation: X1201, X1202 
Type: 50-pin ribbon cable connector 
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Table 2-17 Pin assignment of the connectors X1201 and X1202 

X1201 
Pin Name Description Pin Name Description 
1 GND  2 +24V  
3 KEY1 Input bit 4 KEY2 Input bit 
5 KEY3 Input bit 6 KEY4 Input bit 
7 KEY5 Input bit 8 KEY6 Input bit 
9 KEY7 Input bit 10 KEY8 Input bit 
11 KEY9 Input bit 12 KEY10 Input bit 
13 KEY11 Input bit 14 KEY12 Input bit 
15 KEY13 Input bit 16 KEY14 Input bit 
17 KEY15 Input bit 18 KEY16 Input bit 
19 KEY17 Input bit 20 KEY18 Input bit 
21 KEY19 Input bit 22 KEY20 Input bit 
23 KEY21 Input bit 24 KEY22 Input bit 
25 KEY23 Input bit 26 KEY24 Input bit 
27 not assigned - 28 not assigned - 
29 not assigned - 30 not assigned - 
31 LED1 Output bit 32 LED2 Output bit 
33 LED3 Output bit 34 LED4 Output bit 
35 LED5 Output bit 36 LED6 Output bit 
37  Output bit 38  Output bit 
39  Output bit 40  Output bit 
41  Output bit 42  Output bit 
43  Output bit 44  Output bit 
45  Output bit 46  Output bit 
47 24VDC 24VDC 48 24VDC 24VDC 
49 24VDC 24VDC 50 24VDC 24VDC 

 
 

X1202 
Pin Name Description Pin Name Description 
1 GND  2 +24V  
3 KEY25 Input bit 4 KEY26 Input bit 
5 KEY27 Input bit 6  Input bit 
7  Input bit 8  Input bit 
9  Input bit 10  Input bit 
11 Feed_OV_A Input bit 12 Feed_OV_B Input bit 
13 Feed_OV_C Input bit 14 Feed_OV_D Input bit 
15 Feed_OV_E Input bit 16  Input bit 
17  Input bit 18  Input bit 
19 Sp-OV-A Input bit 20 Sp-OV-B Input bit 
21 Sp-OV-C Input bit 22 Sp-OV-D Input bit 
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X1202 
Pin Name Description Pin Name Description 
23 Sp-OV-E Input bit 24  Input bit 
25  Input bit 26  Input bit 
27 not assigned - 28 not assigned - 
29 not assigned - 30 not assigned - 
31  Output bit 32  Output bit 
33  Output bit 34  Output bit 
35  Output bit 36  Output bit 
37  Output bit 38  Output bit 
39  Output bit 40  Output bit 
41  Output bit 42  Output bit 
43  Output bit 44  Output bit 
45  Output bit 46  Output bit 
47 24VDC 24VDC 48 24VDC 24VDC 
49 24VDC 24VDC 50 24VDC 24VDC 

 

2.6 Interfaces of the DP/DP coupler 
 

 Note 
You can find information on the DP/DP coupler in the "SIMASTIC, DP/DP coupler" manual. 
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Application planning 3
3.1 Overview 

Basic Rules 
The present chapter describes various general rules for electrical design. You must observe 
these rules to ensure trouble-free operation. 

Safety regulations 
To ensure safe operation of your plant, realize the following measures and adapt them to 
your particular conditions: 
• An EMERGENCY OFF concept in accordance with the generally accepted rules of 

current engineering practice 
(e.g., European Standards EN 60204, EN 418 and similar).  

• additional measures for the limiting of limit positions of axes 
(e.g. hardware limit switches). 

• Equipment and measures for protection of motors and power electronics in accordance 
with the SINAMICS Installation Guidelines. 

In addition, in order to identify hazards, we recommend that a risk analysis be conducted on 
the entire system in accordance with the basic safety requirements set out in Appendix 1 of 
EU Machinery Directive 89/392/EEC. 
Also note in this regard the Chapter "ESD Guidelines" in the Appendix of this manual. 

Additional references 
For further information about EMC guidelines, we recommend the publication: EMC 
Installation Guideline, Planning Guide (HW)  
References: /EMC/, Description 

Standards and regulations 
When connecting SINUMERIK 802D sl, please observe the relevant VDE guidelines, in 
particular VDE 0100 or VDE 0113 for disconnecting devices, short-circuit and overload 
protection. 
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3.2 General rules for operation of a SINUMERIK 802D sl 
When integrating a SINUMERIK 802D sl into a plant, you must observe the following general 
rules.  

Starting the plant after certain events 
 

If ... then ... 
Startup after voltage drop or power failure All hazardous operating conditions must be 

avoided. If necessary, force an EMERGENCY 
STOP. 

A startup after unlocking the EMERGENCY-OFF 
equipment  

no uncontrolled or undefined start must occur. 

Mains voltage 
 

At ... make sure that ... 
Stationary plants or systems without all-pole line 
voltage disconnect switch 

the building installation must be equipped with a 
power disconnect switch or a fuse. 

load power supplies, power supply modules the set range of the rated voltage complies with 
the local mains voltage. 

all current circuits deviation of the line voltage from the rated value 
must be within the permitted tolerance (refer to 
"Technical data of the installed components"). 

24VDC power supply 
 

At ... ensure ... 
24 V power supply Safe (electrical) isolation of low voltage  

Protection against external electrical interference 
 

At ... make sure that ... 
all plants, installations and systems in which 
SINUMERIK is installed 

the plant or system is connected to the protective 
conductor for diverting electromagnetic 
interference. 

supply, signal, and bus lines The wiring arrangement and installation complies 
with EMC regulations.  

signal and bus cables a wire break or conductor break does not result in 
undefined states of the plant or system. 
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3.3 Rules regarding current consumption and power loss of a cubicle 
arrangement 

The power loss of all components used in a cabinet must not exceed the maximum amount 
that can be dissipated from the cabinet. 

 

 Note 
When dimensioning the control cubicle, make sure that the permissible ambient temperature 
is not exceeded for the components installed, even in case of high outside temperatures. 

 

For the current consumption and the power loss of the individual modules, please refer to 
Chapter, "Technical Specifications".  
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Assembling 4
Overview 

To install SINUMERIK 802D sl, first secure the individual components on the site of 
installation and then connect them with each other. 

Open Equipment 
The modules of SINUMERIK 802D sl are open-type equipment. This means that you are 
only allowed to install SINUMERIK 802D sl in housings, cubicles or electrical service rooms. 
Access to these housings, cubicles or electrical service rooms must only be possible using a 
key or a tool and must be restricted to instructed or authorized personnel. 

General procedure when installing SINUMERIK 802D solution line 
 

 
Warning 
Before installing or removing the components of the SINUMERIK 802D sl control system, 
make sure that the system is disconnected from the mains. 

 

 

 Note 
When installing the control components, observe the dimensions given in Chapter 
"Dimension Drawings". The drilling patterns constitute the basis for preparing the mounting 
holes. 

 

Mounting the CNC operator panel (PCU) 
Install the CNC operator panel as shown on the relevant illustrations and diagrams in 
Chapter "Dimension Drawings". 
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Caution 
If you do not have access to the back of the controller during installation, you must connect 
the CNC operator panel prior to its installation. When doing so, note that connector X40 
(power supply connection) and the lines connected to it protrude beyond the mounting edge.
When installing the CNC operator panel, do not pull off the connector; otherwise, the cables 
could be damaged! 

 

Installing the machine control panel 
Install the machine control panel as shown on the relevant illustrations and diagrams in 
Chapter "Dimension Drawings". 

Installing the CNC full keyboard 
You can install the CNC full keyboard either next to the operator panel or beneath the CNC 
operator panel. Observe the specifications in the illustrations in Chapter "Dimension 
Drawings". 

Installing the PP72/48 I/O module 
The module must be installed according to EN 60204. Dimension drawing of the module, see 
Chapter "Dimension Drawings". 

Installing the SINAMICS S120 drive 
For information regarding the SINAMICS S120 drive system (design, connection, planning, 
dimensioning, configuring, etc.), see: 
References:/GH1/, /GH2/, Equipment Manuals 
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Connecting 5
5.1 Overall design of the SINUMERIK 802D sl 

 
Figure 5-1 Possibility of supplying the modules via a grounded infeed 
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5.2 Connecting the protective conductor for the individual components 
 

 
Caution 
The individual components shown in the Fig. "Possibility of Supplying Modules" require 
connection to a protective conductor. The individual components must be connected to the 
central grounding point.  
Make always sure that a low-resistance connection is provided to the protective conductor. 

 

Minimum cross-section of the cable to the protective conductor: 10 mm2 
Whereas all remaining components are grounded via a grounding screw, the PP72/48 I/O 
module must be connected directly to the central grounding point via the mounting plate 
(installation acc. to EN 60204). If no grounding can be provided via the mounting plate, it 
must be connected to the central grounding point via an additional line (cross-section ≥ 10 
mm2). 
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5.3 Connection overview for SINUMERIK 802D sl 

 

 
Figure 5-2 Connection overview without MCPA module 
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 Note 
Connect the lines as shown in the "Connection overview without MCPA module" illustration.
The preassembled cable sets from Siemens provide optimum interference immunity. 

 

For information regarding the cables (cable designations, connector types, etc.), see: 
References: /BU/, Catalog or /Z/, Catalog 
For information regarding PROFIBUS–DP and Ethernet, see:  
References: /IKPI/, Catalog  

5.4 Connecting the MCPA module 
The MCPA module is connected to the PCU via X110. The ribbon cable (length 0.6 m, part 
of the MCP 802D sl delivery) is used to connect the machine control panel MCP 802D sl. X1 
is connected to X1201, and X2 to X1202. 
The power supply to the MCPA module is provided via connector X1021 (PIN1 24 V; PIN10 
0 V). 

 

 Note 
The variable assignment of the machine control panel is described in the PLC user interface.
Notes for the Reader:  
/FB/ SINUMERIK 802D sl "Description of Functions" 
PLC subroutine library V01.07.00 of SINUMERIK 802D sl 

 



 Connecting 
 5.5 Connecting an analog spindle 

Operating Instructions 
Operating Instructions, 12/2006, 6FC5397-0CP10-2BA0 53 

 

 
Figure 5-3 Connection overview with MCPA module 

5.5 Connecting an analog spindle 
The setpoint input of the analog spindle is output via the X701 interface on the MCPA 
module. It is possible to set the analog output to be unipolar.  
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The analog spindle is set up using machine data in the controller. 

Connection of a directly mounted spindle actual-value encoder (TTL) 
The TTL encoder requires an SMC 30 module. For configuring the X520 interface (encoder 
connection: TTL encoder with open-circuit monitoring), please refer to the table below.  

Table 5-1 Assignment of the X520 interface 

Description of the female 
connector 

Pin Name Description 

1 Reserved, not 
assigned 

 - 

2 Reserved, not 
assigned 

 - 

3 Reserved, not 
assigned 

- 

4 P_Encoder 5V/24V Encoder power supply 
5 P_Encoder 5V/24V Encoder power supply 
6 P_Sense Sense input encoder power supply 
7 M_Encoder (M) Ground for encoder power supply 
8 Reserved, not 

assigned 
- 

9 M_Sense Ground sense input 
10 R Reference signal R 
11 R* Inverted reference signal R 
12 B* Inverted incremental signal B 
13 B Incremental signal B 
14 A* Inverted incremental signal A 

 

 

15 A Incremental signal A 

 
 

 Caution 
The encoder power supply can be parameterized to 5 V or 24 V. The encoder may be 
destroyed if you enter the wrong parameters. 
Parameter location: 
Machine data of the component (drive object) that the SMC 30 module uses to communicate 
with SINAMICS  
Encoder configuration: 
P404[0].20 for 5 V 
P404[0].21 for 24 V 
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5.6 Connecting the high-speed digital inputs/outputs at the MCPA module 
The high-speed digital inputs/outputs are connected via interfaces X1020 and X1021 of the 
MCPA module. 

5.7 Connecting the power supply 
The required 24 V DC load power supply must be connected to the following connectors:  
• to screw-terminal block X40 of the CNC operator panel 
• to screw-terminal block X1 of the PP72/48 I/O module 

Features of the load power supply 
 

 
Danger 
The 24 V DC protective extra-low voltage must be generated as a protective extra-low 
voltage with safe electrical isolation (to IEC 204-1, Section 6.4, PELV) and grounded by the 
user (provide a PELV M signal connection to the central grounding point of the system).  

 

 

Table 5-2 Electrical parameters of the load power supply for the CNC operator panel (X40) and for 
the PP72/48 I/O module (X1) 

Parameters Values Conditions 
Voltage range mean value 20.4...28.8 V  
Ripple 3.6 Vpp  
Non-periodic overvoltage 35 V 500 ms duration 

50 s recovery time 
Rated current consumption 
• CNC operator panel 
• PP72/48 peripheral module 

 
typically 1 A 
- 

 

Starting current 
• CNC operator panel 
• PP72/48 peripheral module 

2.6A 
- 

 

Power consumption 
• CNC operator panel 
• PP72/48 peripheral module 

 
max. 50 W 
max. 11 W 
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Table 5-3 Pin assignment of the screw-terminal blocks X40 (on the PCU) and X1 (on the I/O 
module) 

Terminal Signal Description 
1 P24 24 V DC 
2 G Ground 
3 PI Protective earth 

 

 

 Note 
Make sure that the interconnecting cable between the power supply and the load power 
supply connection does not exceed a maximum length of 10 m (with PP72/48 I/O module 
only). 

 

Connecting the mains lines 
 

 
Warning 
Before connecting the modules, first disconnect the equipment from the mains! 

 

For connecting the power supply, use flexible lines with a line cross-section of at least 1 
mm2. 
If you only connect one line per connection, end sleeves are not absolutely necessary. 
If you connect several lines per connection, you should use end sleeves. 
Remove the insulation from the cable end, insert the cable end (with end sleeve) into the 
screw terminal connection and tighten the fastening screw. 
Insert the screw terminal with the cables to connection X40 on the CNC operator panel. 

Reverse polarity protection 
With correct connection and the power supply turned on, the LEDs "RDY" (PCU) and 
"POWER" (PP72/48) are lit in green. 

 

 Note 
In the event of polarity reversal, the control system will not work. However, a built-in reverse 
polarity protection will protect the electronics against damage. 
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Fuse 
In case of a defect in the control system, an internally installed fuse protects the electronics 
from collateral damage (e.g. fire). In this case, the entire control system must be replaced. 

5.8 Connecting the NC full keyboard to the CNC operator panel 
The interconnecting cable for connecting the NC full keyboard to the CNC operator panel is 
included in the scope of supply. Connect the female connector X9 on the CNC operator 
panel to the PS/2 socket on the rear of the NC full keyboard.  
For more information, please refer to:  
Reference: /BU/, Catalog 

5.9 Connecting the Ethernet interface 
Connect the Ethernet connection cable to the CNC operator panel, female connector X5. 
Make sure that the connector locks into position when connecting.  

5.10 Connecting the RS232 COM port 
Insert the D-Sub female connectors into connector X8 on the CNC operator panel and into 
the connector on the PG/PC. Lock the connector into position using the knurled screws.  

 

 Note 
Use only shielded lines twisted in pairs; the shield must be connected to the metal or 
metalized connector casing on the side of the control system.  
The cable set offered as accessories provides maximum interference immunity. 

 

Connection diagram 
The diagram below shows the pin assignment of the interconnecting cable between the CNC 
operator panel and a PG/PC with 9-pin or 25-pin socket connector.  
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Figure 5-4 Connection diagram for interconnecting the CNC operator panel and the PG/PC 

 

5.11 Connecting the PP72/48 I/O module 

PNO design guidelines 
For electrical PROFIBUS networks, observe also the PROFIBUS–DP/FMS design guidelines 
of the PROFIBUS user organization. They contain important measures for the cable routing 
and for starting up PROFIBUS networks.  
Publisher: PROFIBUS–Nutzerorganisation e.V. 
Haid–und–Neu–Straße 7 
76131 Karlsruhe, Germany 
Tel: +49 721 / 9658 590 
Fax: +49 721 / 9658 589 
Internet: http://www.profibus.com 
Guideline, order no. 2.112 
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Bus node 
The following bus nodes can be connected via the PROFIBUS–DP interface: 
• CNC operator panel (always master) 
• PP72/48 I/O module (slave) 

Bus connector and bus cable 
The PROFIBUS cable is a two-core, stranded and shielded cable which must not be twisted, 
stretched or squeezed. 
For more information regarding the bus connector, the bus cable and the cable length, 
please refer to: 
References: /BU/, Catalog 

Connecting the Bus Connector 
To connect the bus connector, proceed as follows: 
1. Plug the bus connector into the module. 
2. Screw the bus connector firmly into place. 
3. If the bus connector is at the start or end of the PROFIBUS–DP connection, you must 

connect the terminator on the connector (switch position "ON"). 
 

 
Figure 5-5 Bus connector terminating resistor switched on and off 

 
 

 
Warning 
A bus segment must always be terminated on both ends; otherwise, the data traffic at the 
bus could be disturbed. 
Please make sure during startup and normal operation that power is always supplied to 
stations where the terminating resistor is active. 
The terminator is without effect if the last station to which a bus connector is connected is 
dead, since the bus connector is powered from the station. 

 

Networking example 
The diagram below shows a networking example for SINUMERIK 802D sl with two PP72/48 
I/O modules. 
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Figure 5-6 Networking example 
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5.12 Connecting the DP/DP coupler 

Cross-control PLC data interface 
The DP/DP coupler is used to link two PROFIBUS DP networks together and to transfer data 
from the master of one network to the master of the other network. 
For SINUMERIK 802D sl, 16 bytes are available for receiving and 16 bytes are available for 
sending. For more information, see the "SIMATIC DP/DP coupler" manual. 

 

 Note 
DP/DP coupler as of Version B2 
Order number: 6ES7158-0AD01-0XA0 
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Figure 5-7 Using DP-DP coupler (example) 



 Connecting 
 5.13 Connecting the SINAMICS drive to the DRIVE-CLiQ interface 

Operating Instructions 
Operating Instructions, 12/2006, 6FC5397-0CP10-2BA0 63 

5.13 Connecting the SINAMICS drive to the DRIVE-CLiQ interface 
Connect the female connector X1 or X2 on the CNC operator panel to the X200 female 
connector on the drive using the DRIVE-CLiQ signal line.  
 

 
Figure 5-8 Connection with ALM (Active Line Module) and DRIVE-CLiQ 

 
 

 
Figure 5-9 Connection with SLM (Smart Line Module) and DRIVE-CLiQ 

*) Input from the measuring system 
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 Note 
The connection with SLM and DRIVE-CLiQ is made like the connection with ALM and 
DRIVE-CLiQ. 

 

With SMI motors (integrated measuring system interface), the connection is provided from 
the motor directly to X202 via the DRIVE-CLiQ line. For direct measuring systems, connect 
the measuring system via a SMCxx module (xx depends on the type of the measuring 
system you are using: e.g. SMC20 with incremental encoder or SMC30 with TTL encoder). 

5.14 Connecting the digital inputs/outputs to the PCU 

Connection cables 
To connect the digital inputs and outputs, you should use flexible lines with a cross-section 
of at least 0.5 mm2 .  
If you only connect one line per connection, end sleeves are not absolutely necessary. 
If you connect two lines per connection, lines with a cross-section between 0.25 and 0.75 
mm2 with end sleeve must be used. 
Fasten the lines to the supplied screw terminals and insert the terminals to the connectors 
X20 and X21 on the CNC operator panel. 

 

 Note 
To ensure optimum interference immunity when connecting probes or BEROs, shielded lines 
must be used.  
The max. line length is 30 m.  

 

5.15 Connecting the digital inputs/digital outputs to the PP72/48 I/O module 
You can use the I/O interfaces X111, X222, X333 as digital inputs or digital outputs. To this 
end, fasten the insulation displacement connector to the ribbon cable and route it from the 
I/O module to the terminal strip converter. The individual wiring can be performed on the 
terminal strip converters.  
Remove the insulation from the cable end, insert the cable end (with end sleeve) into the 
screw terminal connection and tighten the fastening screw. 
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5.16 Connecting the machine control panel to the PP72/48 I/O module 
Connect the machine control panel (X1201 and X1202) to the PP72/48 I/O module (e.g. 
X111 and X222) using two ribbon cables.  
For more information, please refer to:  
References: /BU/, Catalog 

 

 Note 
You can find more information regarding the machine control panel and the pin assignment 
of the connectors X1201 and X1202 in Chapter "Interfaces of MCPA module". 

 

5.17 Connecting shielded cables via the shield connection (PCU) 
The shield of shielded signal lines must be connected to ground. The connection to ground is 
achieved by connecting the shield connection directly to the housing.  

Shield connection 
EMC shield clips (2 units) are used as the shield connection and are part of the scope of 
delivery of the CNC operator panel. 

Mounting the shield connection 
1. Remove the isolation from the shield according to the EMC shield clip. 
2. Place the shield on the housing in the appropriate place (see Figure below). 
3. Screw the EMC shield clips onto the housing. 

Ensure firm fit of the cable on the housing. 
4. For mechanical strain relief of the lines and cables, you can use the cable clamp or the 

EMC shield clips (see Figure below). 
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Figure 5-10 Connecting and securing shielded lines via the shield connection 
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Operation (hardware) 6
6.1 Operator control and display elements 

Operator control elements 
The defined functions are called up via the horizontal and vertical softkeys. For a description, 
please refer to this manual: 
 

 
Figure 6-1 CNC operator panel 

6.2 Status and error displays 

Display of the LEDs on the operator panel CNC (PCU)  
The following LEDs are installed on the operator panel CNC.  
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The individual LEDs and their functions are described in the table below. 

Table 6-1 Status and error displays 

LED Meaning 
ERR (red) Serious error, remedy through power OFF/ON  
RDY (green) Data Set Ready 
NC (yellow) Signoflife monitoring 
CF (yellow) Reading from/writing to CF card  

Note for the reader 
You can find information on error description in  
/DG/, SINUMERIK 802D sl, Diagnostics Manual 

LED displays on the PP 72/48 I/O module 
The following LEDs are installed on the I/O module:  

Table 6-2 Status displays 

LED Meaning 
POWER (green) Power supply of the electronic equipment ready for operation 
READY (red) I/O module ready for operation; but no cyclic data exchange with DP Master 

is performed 
EXCHANGE (green) I/O module ready for operation; cyclic data exchange with DP Master is 

performed 
OVTEMP (red) Overtemperature indication 
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Commissioning (General) 7
7.1 Initial commissioning (IBN) 

Commissioning requirements 
• You will need the following: 

– SINUMERIK 802D sl User Documentation 
– SINUMERIK 802D sl Description of Functions 
– Lists manual for the SINUMERIK 802D sl 
– A PC for commissioning and data backup 
– Tools installed from the Toolbox CD: 

RCS802 Commissioning and Diagnostic Tool 
PLC802 Programming Tool 
802D sl Configuration Data 
PLC Library 
STARTER (for optimizing the drive) 
Adobe Acrobat Reader 

• The mechanical and electrical installation of the system must be completed. 

Commissioning sequence 
To commission the SINUMERIK 802D sl, proceed as follows: 
1. Check that the PCU boots. 
2. Load language files 
3. Load technology 
4. Set the general machine data. 
5. Set the PROFIBUS addresses 
6. PLC commissioning 
7. Start up the drive. 
8. Set the axis/spindle-specific machine data. 

– Match the encoder to the axis / spindle. 
– Match the setpoint to the axis / spindle. 
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9. Perform a dry run for the axes and for the spindle. 
10. Drive Optimization 
11. Complete the commissioning; perform a data backup. 

7.2 Access levels 

Protection levels 
The SINUMERIK 802D sl provides a concept of protection levels for enabling data areas. 
The various access authorizations control the protection levels 0 to 7 whereby 0 is the 
highest and 7 the lowest level.  
The control system is delivered with default passwords for protection level 1 to 3. 

Table 7-1 Access level concept 

Protection level Locked by range 
0  Siemens, reserved 
1 Password: SUNRISE (default) Expert mode 
2 Password: EVENING (default)  Machine manufacturer 
3 Password: CUSTOMER (default) Authorized operator, setter 
4 to 7 No password/deleted password and user 

interface from PLC → NCK 
Authorized operator, setter or 
appropriate graduations as desired 

In the menus listed below the input and modification of data depends on the protection level 
set: 
• Tool offsets 
• Work offsets 
• Setting data 
• RS232 settings 
• Program creation / program correction 
The protection levels can be set for these function areas using the display machine data 
(USER_CLASS...) 

Protection levels 1 ... 3 
The protection levels 1 to 3 require a password. Passwords can be changed after activation. 
If they are no longer recognized, a reinitialization must be carried out (power up with default 
machine data). This will reset all passwords to their defaults according to the software 
release you have acquired. 
The password remains set until it is reset by selecting the <Delete password> softkey. 
POWER ON will notreset the password. 
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Protection levels 4 ... 7 
Protection level 7 is set automatically if no password is set and no protection level interface 
signal is set. The protection levels 4 to 7 can be set from the PLC user program even without 
a password by setting the bits in the user interface.  

 

 Note 
Setting of the access levels is described in the Programming and Operating Manual. 

 

7.3 RCS tool 
With the RCS tool (Remote Control System), you are provided with an Explorer tool for your 
PC/PG to assist you in your daily work with SINUMERIK 802D sl.  
The connection between the control system and the PC/PG can be provided either via an 
RS232 cable or a local network cable (optional). 

 

 Notice 
You will obtain the full functionality of the RCS tool only after importing the license key RCS 
802. 
With this key, the connection to the control system can be established via a local network 
(only for SINUMERIK 802D sl pro) and the remote operating function and other functions can 
be used. 
Without a license key, only local directories (on the PC/PG) are released for accessing via 
the control system. 

 

 

 
Figure 7-1 Explorer window of the RCS tool 
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After starting, you are in offline mode. This means that you can manage files on your PC 
only. In the online mode, the Control 802 directory is also available for data exchange with 
the control system. In addition, a remote control function is provided for process monitoring. 

 

 Note 
The RCS tool provides a detailed online help function. For further details e.g. establishing a 
connection, project management etc., please refer to this help menu. 

 

 

7.4 STARTER commissioning tool 
To launch the STARTER program, click the STARTER icon or choose Start > Programs> 
STARTER > STARTER from the Windows Start menu.  

 

 Note 
The screen forms of the STARTER tool, version V3.2, are shown in the following. If your 
particular version deviates from the version used here, your screen forms may deviate 
slightly from those shown here.  

 

7.4.1 The STARTER user interface 
You can use STARTER to create the sample project. To perform the individual 
configurations, use the user interface areas listed below:  
• Project navigator: This area displays the elements and objects you will insert into the 

project.  
• Working area: Use this area to perform your task for creating the project:  

– When you are configuring the drive, this area contains the Wizards that help you 
configure the drive objects. 

– If you configure, for example, the parameters for the speed setpoint filter. 
– When you call up the expert list, the system displays a list of all the parameters that 

you can view or change. 
• Detailed view: This area provides detailed information, for example, on faults and 

warnings.  



 Commissioning (General) 
 7.4 STARTER commissioning tool 

Operating Instructions 
Operating Instructions, 12/2006, 6FC5397-0CP10-2BA0 73 

 
Figure 7-2 The different areas of the STARTER user interface 

7.4.2 Operating philosophy of the STARTER commissioning tool for SINAMICS S120 
When creating a drive unit for a SINAMICS S120 system, the following operating philosophy 
is assumed: 
The tool is used to process objects (e.g. infeed). The object name is user defined. 
A drive unit in the terms of the STARTER commissioning tool is always a control unit and the 
appropriate drives.  
With a controlled infeed, the Active Line Module is configured in STARTER. An uncontrolled 
infeed is not represented in STARTER. 
The appropriate drive consists, for example, of a Motor Module (power section) and of a 
motor with encoder.  
The following figure shows the project navigator in STARTER. A project with the name 802D 
sl and a drive unit with the name SINAMICS_IN_802D have been configured for 6 drives. 
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Figure 7-3 SINAMICS_IN_802D 

7.4.3 Diagnosis via STARTER 

Description 
The diagnostic functions support commissioning and service personnel during 
commissioning, troubleshooting, diagnostics and service activities. 

General information 
Prerequisites: STARTER is in the online mode. 
The following diagnostic functions are available in STARTER: 
• PROFIBUS diagnostic buffer 

The message output window shows the states of the control/status words, parameters 
and drive enable signals for the selected drive/device. 

• Fault/alarm display in the alarms output window 
The faults and alarms for one or more drives/devices can be displayed. The fault/alarm 
description is called up by selecting "Help -> Context" or by pressing the SHIFT + F1 
keys. 

• Diagnostics overview 
An overview table is displayed containing all the drives available in the project. 
– Device: the available devices and drives are displayed with names; the device status 

is output in the "device diagnostics" window. 
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– Operating state: It is not possible to control the current status (e.g. OFFLINE, 
ONLINE, IBN, STOP) on SINUMERIK 802D sl using the operating modes selector 
switch. 

• Specifying signals with the ramp-function generator 
• Signal recording with the trace function 
• Analyzing the control response with the measuring function 

7.4.3.1 Function generator 

Description 
The function generator can be used, for example, to perform the following tasks: 
• for measuring and optimizing closed-loop control circuits; 
• for comparing the dynamic properties of coupled drives; 
• for specifying a straightforward traversing profile without traversing program. 
With the function generator as the setpoint source, it can be used to generate various signal 
forms.  
The output signal can be supplied to the closed-loop control circuit via the BICO circuit in the 
"Connector output" mode. 
In the Servo mode, this setpoint can additionally be supplied into the control structure in 
accordance with the currently selected mode of the function generator, for example, as a 
current setpoint, disturbing torque or speed setpoint. Any influence of overlaid closed-loop 
control circuits is suppressed automatically. 

Parameterizing and operating the function generator 
The function generator is parameterized and operated via the STARTER parameterization 
and commissioning tool. 
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Figure 7-4 Figure 1–4 "Function generator" start screen 

 

 Note 
Please refer to the online help for more information about parameterizing and using the 
measuring sockets. 

 

Features 
• The following parameterizable signal forms can be set: 

– Rectangle 
– Staircase 
– Triangle 
– PRBS (pseudo random binary signal, white noise) 
– Sinusoidal 

• An offset is possible for each signal. The power-up to the offset can be parameterized. 
The signal generation starts after the power-up for the offset. 

• Restriction of the output signal to the minimum and maximum value can be set. 
• Operating modes of the function generator for servo and vector only 
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– Connector output 
• Operating modes of the function generator for servo only 

– Current setpoint downstream of the filter (current setpoint filter) 
– Disturbing torque (downstream of the current setpoint filter) 
– Speed setpoint downstream of the filter (speed setpoint filter) 
– Current setpoint upstream of the filter (current setpoint filter) 
– Speed setpoint upstream of the filter (speed setpoint filter) 

Switching points of the function generator 

--

 

 
Figure 7-5 Switching points of the function generator 

Further signal forms 
Further signal forms can be produced by parameterization. 
Example: 
The "triangular" signal form can be parameterized with "upper limitation" to produce a 
triangle with no peak. 

 

 
Figure 7-6 "Triangular" signal without peak 

Starting/stopping the function generator 
 

 
Caution 
With the corresponding ramp-function generator parameter settings (e.g. offset), the motor 
can "drift" and travel to its end stop. 
The motion of the drive is not monitored with the function generator activated. 
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To start the function generator, proceed as follows: 
1. Provide for the prerequisites for starting the function generator. 

– Activate the control panel. 
Drives –> Drive_x –> Commissioning –> Control panel 

– Turn on the drive. 
Control panel -> Issue enables -> Switch on 

2. Select operating mode 
e.g. speed setpoint downstream of the filter. 

3. Select the drive (as the control panel). 
4. Set the signal form, 

e.g. rectangle 
5. Load the settings to the target system ("Download parameters" pushbutton) 
6. Start the ramp-function generator ("Start FctGen" pushbutton) 
To stop the function generator, proceed as follows: 
"Stop FctGen" pushbutton 

Configuration 
 
The "function generator" parameter screen is selected via this icon in the toolbar of the 
STARTER commissioning tool: 

7.4.3.2 Trace function 

Description 
The trace function can be used to acquire measuring values over a specified period, 
depending on the trigger conditions. 

Parameterizing and operating the trace function 
The trace function is parameterized and operated via the STARTER parameterization and 
commissioning tool. 
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Figure 7-7 Figure 1-8 "Trace function" start screen 

 

 Note 
Please refer to the online help for more information about parameterizing and using the 
measuring sockets. 

 

Features 
• Four recording channels per recorder 
• Two independent trace recorders per Control Unit 
• Triggering 

– Without triggering (recording immediately after start) 
– Triggering on signal with edge or on level 
– Trigger delay and pretrigger possible 
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• STARTER parameterization and commissioning tool 
– Automatic or adjustable scaling of display axes 
– Signal measurement via cursor 

• Settable trace cycle: integers of the base sample time 

Configuration 
 
The "trace function" parameter screen is selected via this icon in the toolbar of the 
STARTER commissioning tool.  
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Initial start-up 8
8.1 Turning on and booting the control system 

Procedure 
• Check the system visually for: 

– correct mechanical design and check that all electrical connections are performed 
correctly. 

– Supply voltage 
– connection of shielding and grounding. 

• Connect the control system (booting in the normal mode) 

Booting in the normal mode 
When the control system is turned on, the boot sequence is displayed on the control system 
with all its individual phases. Once the start screen of the user interface has appeared, the 
booting sequence is completed. 

Booting in the start-up mode 
After POWER ON and once the operating system has been started, the words "SINUMERIK 
Solution line" are displayed filling the whole screen. Once these words disappear, press the 
SELECT key. 
The START UP MENU is displayed. Use the arrow key to select an appropriate power-
up/start-up mode and press <ENTER> to confirm. 
If there is no password set, the following modes are available: 
• Normal startup 

If this option is chosen, the control system will boot with the last machine data set and the 
previously loaded programs. 

• Reload saved user data 
The user data (machine data, programs, etc.) that was backed up to the flash memory 
are accepted as the current data and the boot up is carried out. 

• software update 
In this case, the control system will not boot at all. The software can only be updated if a 
CF card with a software update is inserted in the slot for the CF card. 

If there is a password set, the following modes are available:  
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• Normal startup 
• Reload saved user data 
• Startup with default data (is only displayed if protection level 1 or 2 is set) 

If this option is chosen, the control system will boot with default machine data. 
• PLC stop 

Select PLC Stop while the control system is booting if PLC Stop can not be triggered via 
the user interface any more. 

• PLC overall reset / default PLC program 
All PLC variables are reset, a NOP (no operation) program is loaded. 

• HMI startup with default data 
The HMI will power up with default machine data. 

• Remove drive data 
The drive machine data is reset and the default setting is loaded. 

• Remove drive data/default data 
The drive machine data is reset and the default data is loaded. 

• software update 
In this case, the control system will not boot at all. The software can only be updated if a 
CF card with a software update is inserted in the slot for the CF card. 

8.2 Language setting and file management 
The default setting of the controller for both the foreground and background language is 
English. You can change the languages by loading new language files from the toolbox 
using the RCS802 tool.  

8.2.1 Creating and Editing Projects 

Prerequisites 
The RCS802 tool and the toolbox are installed on the PC/PG. 

Creating a project 
• Start RCS802 on the PC. 
• Select the Toolbox > Controller menu item from the Settings menu bar and select the 

802D sl control. 
• Select the Toolbox version under Settings > Toolbox > Select Version and Project  and 

click on Project (1). 
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• In the menu display (2), click on New, the system then opens the Create new project 
window (3). 

• Enter a name for the new project and select the foreground and background language. 
Confirm the entry Create. The system creates the new project and displays it in the 
project overview (4). 

 

  Note 
To activate the project selected, click on OK in the project overview(4).  

 

 

 
Figure 8-1 Creating a project  

Editing a project 
• Start RCS802 on the PC. 
• Select the Toolbox version under Settings > Toolbox > Select Version and Project  and 

click on Project (1). 
• Select the project to be edited in the project overview (4) and click on Modify. 
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Figure 8-2 Editing a project 

• In the subsequent menu display, you can add languages to or remove languages from 
the project. 

8.2.2 Help, language and alarm files 
To create the help system, select the menu item Tools > Toolbox Manager > Generate Help 
System  from the RCS802 menu bar. Here you can also create a new language or new text 
files. You can either edit or delete (1) existing text files. By clicking on Generate Helptext (2), 
you can generate the help system to be generated subsequently.  

 
Figure 8-3 Generating text files for the online help 

To transfer the help system to the control system, there must be a connection between 
PC/PG and the control system. After the generation, you can make the transfer to the control 
system by clicking on Transfer to 802. 
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Figure 8-4 Transferring data to the control system 

You can select and transfer foreground and background languages under Tools > Toolbox 
Manager > Select Language. 

 
Figure 8-5 Transferring the language 

Texts for PLC user alarms (alcu.txt), user cycles (alsc.txt) and NC user alarms (alz.txt) can 
be created using the Tools > Toolbox Manager > Select OEM menu. User stands here for 
both end user and machine manufacturer. 

 
Figure 8-6 Changing OEM files 
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8.3 Setting the technology 
 

 Note 
The SINUMERIK 802D sl is delivered with default machine data. In the next step, the 
appropriate setup file must be loaded from the toolbox into the control system.  

 

The following technology can be configured using setup files: 
• Lathing 
• Milling 
• external cylindrical grinding and 
• Nibbling 
From the installed toolbox, the setup file relevant for the technology is to be used in 
conjunction with the control system variant (value, plus, pro). 
The setup file must be loaded during the commissioning after booting of the control system, 
but prior to the general configuration. 

 

 Notice 
The trafo_Mx.ini describes memory-standardizing machine data. The data must be saved by 
creating and rereading a series start-up file. 

 

 

 Note 
Please always observe the readme file supplied with the "Toolbox". It provides up-to-date 
information. 

 

Lathing configuration  
• setup_T.arc 

contains the complete setup for the lathing technology, including standard cycles. 
• setTra_T.arc 

contains the complete setup for the lathing technology, including standard cycles with a 
second spindle for the options TRANSMIT, TRACYL and the use of milling cycles. 
Note: Only load one of the two setup files. 

• trafo_T.ini 
Text file - only for the lathing technology. These settings are supplemented by the lathing 
technology with machine data for the second spindle and for the options 
TRANSMIT/TRACYL. 
Note: If you use milling cycles, load the cycles.spf file into the control system. 
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• trafo_Mx.ini 
Text file for milling applications on the lathe. These settings are supplemented by the 
lathing technology with machine data for the second spindle and for the option TRACYL. 
– trafo_MA.ini: for rotary axis A 
– trafo_MB.ini: for rotary axis B 
– trafo_MC.ini: for rotary axis C 

• setISO_T.arc 
Binary file for switching from SIEMENS mode to ISO mode lathing (B code) with 
simulation axes and spindle. 

• isoTra_T.arc 
Binary file for switching from SIEMENS mode to ISO mode lathing (B code) with second 
spindle. 

• ISO_A_T.ini 
Text file for switching from ISO mode B code to ISO mode A code 

• ISO_C_T.ini 
Text file for switching from ISO mode B code to ISO mode C code 

• ISO_B_T.ini 
Text file to switch back from ISO mode A code or C code to B code 

• turnG22.ini 
Text file to switch on the function "STORED STROKE CHECK FUNCTION". 

Milling configuration: 
• setup_M.arc 

contains the complete setup for the milling technology, including standard cycles. 
• setISO_M.arc 

Binary file for switching from SIEMENS mode to ISO mode milling with simulation axes 
and spindle. 

• ISOG70_M.ini (to use G70/G71 for INCH/METRIC) 
Text file to use the function G70/G71 for INCH/METRIC switchover also in the ISO mode 
milling. 

• millG22.ini 
Text file to switch on the function "STORED STROKE CHECK FUNCTION". 

External cylindrical grinding configuration: 
• setup_G_C.arc 

contains the complete setup for the external cylindrical grinding technology with Cartesian 
X-Z axes, including standard cycles. 

• setup_G_C_inc.arc 
contains the complete setup for the external cylindrical grinding technology with Cartesian 
X-Z axes (inclined axis with fixed angle), including standard cycles. 
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Nibbling configuration: 
• setup_N.arc 

contains the complete setup for the nibbling technology with mechanically coupled die. 
• setup_N_MC.arc 

contains the complete setup for the nibbling technology with die coupled via servo axis. 

Sequence of operations 
• Establishing a connection between PC and the control system (CNC operating panel) 
• Turn on the control system and wait until the control system has completed its booting 

sequence without errors. In the "System" operating area, set the password for protection 
level 2 or higher. 

• Start RCS802 on the PC and establish a connection between the PC and the control 
system using the  button. 

• Use Copy/Paste to copy the icon of the setup file into the "Data" folder of drive A of your 
802D sl.  
If the toolbox has been installed in the default directory, the setup files are to be found, 
e.g. at  
C:\Programs\Siemens\Toolbox 
802Dsl\V030005\V01xxyyzz\TECHNO\MILLING\CONFIG_xx\ 

• The control system boots automatically during the transmission several times. 
• The SINUMERIK 802D sl is now preset to the required technology. 

8.4 Input of the machine data 

Overview 
The most important machine data of the individual subareas are listed here to assist you. 
The detailed description of the machine data and interface signals is given in the Parameter 
Manual with cross-references to the section on function description. 

 

 Note 
The machine data is preset by loading the technology files in such a manner that a change 
to the values is only required in exceptional cases. 

 

Entering the machine data (MD) 
Before you can enter the machine data, the password for protection level 2 must be set. 
Use the relevant softkey to select the following machine data areas and to change the 
machine data if necessary: 
• General machine data MD 10000 ... 19999 
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• Channel machine data MD 20000 ... 29999 
• Axis machine data MD 30000 ... 39999 
• Display machine data MD 1 ... 999 
• Setting data 

– General setting data 
– Channel-specific setting data 
– Axis-specific setting data 

• Drive machine data r0001 ... r9999 (read-only) 
 p0001 ... p9999 (read and write-enabled) 

The data you have entered are written to the data memory immediately. An exception is the 
drive machine data. To save the drive machine data permanently, set the parameter p971 in 
the SINAMICS for each individual drive object separately or set p977 of the CU_I to "1" and 
wait until it is reset automatically. If you forget to save the data, the old data is effective again 
after the next drive reset.  
The machine data is activated depending on the machine data property "Activated". 

8.5 Activating the high-speed digital inputs/digital outputs 

Setting the Machine Data 
The high-speed digital inputs/outputs are activated using the following machine data: 

 
MD10350 FAST_DIG_NUM_INPUTS  
MD10360 FAST_IO_DIG_NUM_OUTPUTS  
MD10366 HW_ASSIGN_DIG_FASTIN[0]  
MD10368 HW_ASSIGN_DIG_FASTOUT[0]  

Example 
The machine data MD10350 and MD10360 will be or are already set to 2. The machine data 
MD10366 and MD10368 must be input as follows (MCPA module as optional module 1 of 
the local bus): 

 
4. Byte: 00 Segment number for LOCALBUS 
3. Byte: 01 Module number (MCPA) 
2. Byte: 01 Interface-module number 
1. Byte: 01 I/O byte number 
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Table 8-1 Example of machine data setting 

Machine data Value Explanation 
MD10350 FAST_IO_DIG_NUM_INPUTS 2 Number of input bytes *) 
MD10360 FAST_IO_DIG_NUM_OUTPUTS 2 Number of output bytes *) 
MD10366 HW_ASSIGN_DIG_FASTIN[0] 00 01 01 01 Hardware assignment MCPA 
MD10368 HW_ASSIGN_DIG_FASTOUT[0] 00 01 01 01 Hardware assignment MCPA 

*) The first I/O byte is reserved for Sinamics. 

The example shows that a total of 2 bytes for inputs/outputs are available. The MCPA 
inputs/outputs are arranged by addresses according to the always reserved addresses for 
onboard I/Os. Within part programs, the MCPA inputs/outputs can therefore be addressed by 
bits as follows: 
• Inlets: $A_IN[9] ... $A_IN[16] 
• Outlets: $A_OUT[9]...$A_OUT[16] 

 
...  

N100 R1= $A_IN[9] ; Reading digital input 1 of the MCPA module 
N200 $A_OUT[16] = 1 ; writing a 1 on the last digital output of the MCPA module  
N300 R2=$A_OUT[16] ; Reading of the output Bit8 

 

8.6 Setting the Profibus addresses 
Each bus station must be assigned a PROFIBUS DP address at the PROFIBUS–DP for 
unambiguous identification. Each PROFIBUS–DP address must be assigned at the bus only 
once. 

Table 8-2 Setting the Profibus address 

MD 11240[2] PB station (slave) PB address 
PP module 1 9 
PP module 2 8 
PP module 3 7 

0 

Additional preconfigured PB station: DP-DP coupler 6 

PCU 
The PCU is the master on the PROFIBUS. The address cannot be changed 

PP 72/48 
The PP 72/48 I/O module is the slave on the PROFIBUS. max. three PP modules can be 
connected. The PROFIBUS–DP address is set using the DIL switch S1 (on the PP module). 
Use a screw driver to set the PROFIBUS–DP address. It results from adding the switches 
that are in the "ON" position (left). 
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Figure 8-7 Setting the PROFIBUS DP address on PP72/48 

Table 8-3 Setting the Profibus address on the PP 72/48 

PB address DIL switch S1 (PP module) 
9 (default setting) 
(PP module 1) 

1 + 4 = ON 
2 + 3 + 5 + 6 + 7 + 8 = OFF 

8 
(PP module 2) 

4 = ON 
1 + 2 + 3 + 5 + 6 + 7 + 8 = OFF 

7 
(PP module 3) 

1 + 2 + 3 = ON 
4 + 5 + 6 + 7 + 8 = OFF 

 

 

 Note 
The newly set PB station address is only active after POWER ON. 

 

Use of three PP 72/48 I/O modules 
If three PP 72/48 I/O modules are used, the assignment of the input/output bytes will be as 
follows: 

Table 8-4 Assignment of the input/output bytes 

1. PP 72/48 I/O module, PROFIBUS DP address 9 
Connector X111 X222 X333 
Input byte 0...2 3...5 6...8 
Output Byte 0...1 2...3 4...5 
    
2. PP 72/48 I/O module, PROFIBUS DP address 8 
Connector X111 X222 X333 
Input byte 9...11 12...14 15...17 
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Output Byte 6...7 8...9 10...11 
    
3. PP 72/48 I/O module, PROFIBUS DP address 7 
Connector X111 X222 X333 
Input byte 18...20 21...23 24...26 
Output Byte 12...13 14...15 16...17 

DP/DP coupler 
The DP/DP coupler is the slave on the PROFIBUS. One DP/DP coupler can be connected at 
the most. The PROFIBUS–DP addresses are set via the DIL switch on the DP/DP coupler. 
Use a screw driver to set the PROFIBUS–DP address. It results from adding the switches 
that are in the "ON" position. 
The PROFIBUS DP address 6 must be set at the DP/DP coupler on the part of 
SINUMERIK 802D sl (network 1 = DP1 – switch 2+4 on). The second address (network 2 = 
DP2) is user defined.  
On the part of the 802D, first 16-byte digital inputs and then 16-byte digital outputs are 
parameterized by the fixed parameterization in the DP coupler. In the 802D, these are 
placed on the input bytes 18 ... 33 or the output bytes 12 ... 27. 
Thus on the second side of the DP/DP coupler, you must mirror that by first setting the 16-
byte digital outputs and then the 16-byte digital inputs. You are free to decide on which 
input/output bytes you place these in your control system. (see the SIMATIC DP/DP coupler 
manual) 
You may quickly test the function in SINUMERIK 802D sl under System / PLC Status. 
IB 27 B _ _ _ _ _ _ _ _ 
QB 18 B _ _ _ _ _ _ _ _ 

Table 8-5 Setting the Profibus address on the DP/DP coupler 

PB address DIL switch DP1 (SINUMERIK 802D sl) network 1 
6 2 + 4 = ON 

 
 

PB address DIL switch DP2 (SINUMERIK 802D sl) network 2 
can be freely selected. can be freely selected. 

When you use the DP/DP coupler, the following assignment of the input/output bytes result: 

Table 8-6 Assignment of the input/output bytes 

DP/DP coupler network 1, PROFIBUS DP address 6 
Input bytes 27 ... 42 (16 byte) 
Output bytes 18 ... 33 (16 byte) 
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Changing the PROFIBUS–DP address 
You can change the PROFIBUS–DP address once set at any time. However, the control 
system will accept the newly set PROFIBUS–DP address only after turning off / turning on 
the 24 V DC power supply. 

See also 
Digital inputs/outputs (Page 25) 

8.7 Starting Up the PLC 
After starting up the Profibus, a PLC user program is ready to run and can be used for 
further start-up. To load the PLC user program, use the Programming Tool. 
The description for this can be found in section "PLC application download...".  

8.8 Commissioning of drives (SINAMICS) 
The following options are available for commissioning the SINAMICS S120 with the 
SINUMERIK 802D sl: 
1. Commissioning via the HMI 
2. Editing drive projects with the STARTER commissioning tool 
The descriptions for this can be found in Chapter "Commissioning of drives". 

8.9 Set the axis/spindle-specific machine data. 

Setpoint/actual value assignment 
The axis machine data MD 30130: CTRLOUT_TYPE can be used to switch the setpoint 
output, and MD 30240: ENC_TYPE can be used to switch the actual-value input between 
simulation and SINAMICS drive. 

Table 8-7 Setpoint/actual value assignment 

Machine data Simulation Normal operation 
MD 30130 Value = 0 

Simulation 
Value = 1 
In this case, the setpoint signals are output via 
Profibus. 

MD 30240 Value = 0 
Simulation 

Value = 1 (INCR) or 4 (EnDat) 
In this case, the actual values are read in via Profibus.
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 Note 
For simulation, MD 30130 and MD 30240 must be parameterized with "0". 

 

To enable the relevant NC axis to assign its setpoint to the appropriate SINAMICS drive, 
ensuring that the actual values are returned from this SINAMICS drive, it is imperative to 
parameterize the machine data MD 30110: CTRLOUT_MODULE_NR and MD 30220: 
ENC_MODULE_NR. 
The following applies for the maximum configuration of 6 axes with Active Line Module: 

Table 8-8 maximum configuration 

Axis Drive number 
MD 30110 
MD 30220 

SINAMICS object no. 

SP 1 3 
X1 2 4 
Y1 3 5 
Z1 4 6 
A1 5 7 
PLC axis 6 8 

 
If this setting does not match the order in the drive group (the order of the DRIVE-CLiQ 
connections corresponds to the order of the SINAMICS object no., here: 1. CU, 2. ALM, 3. 
Spindle, 4. X1 axis, 5. Y1 axis, 6. Z1 axis, 7. A1 axis, 8. PLC axis), the data must be adapted 
accordingly. 
Example 1: 
Milling machine/nibbling machine with three axes and one spindle. 
• The technology data block (setup_M.arc) has been loaded. 
• The bus configuration has been selected with MD 11240[2] = 0. 
• Now, adapt the axis machine data MD 30110: CTRLOUT_MODULE_NR and MD 30220: 

ENC_MODULE_NR are adapted as follows: 

Table 8-9 Adapting the axis machine data for the milling machine 

Axis Drive number 
MD 30110 
MD 30220 

Sinamics object no. 

X1 2 4 
Y1 3 5 
Z1 4 6 
SP 1 3 
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Table 8-10 Adapting the axis machine data for the nibbling machine 

Axis Drive number 
MD 30110 
MD 30220 

Sinamics object no. 

X1 2 4 
Y1 3 5 
SP 1 3 

• Set the PB addresses = object no. of the drives as specified in the table above. Due to 
the fact that the 5th axis (A1) is not used, MD 20070: AXCONF_MACHAX_USED[4]=0 
must be parameterized. This will remove the axis from the configuration of the NC. 

Example 2: 
Lathe/grinding machine with two axes and one spindle/two spindles. 
• The technology data block (setup_T.arc) has been loaded. 
• The bus configuration has been selected with MD 11240[2] = 0. 
• Now, adapt the axis machine data MD 30110: CTRLOUT_MODULE_NR and MD 30220: 

ENC_MODULE_NR are adapted as follows: 

Table 8-11 Adapting the axis machine data  

Axis Drive number 
MD 30110 
MD 30220 

Sinamics object no. 

X1 2 4 
Y1 3 5 
SP 1 3 
A1 4 6 

• Set the PB addresses = object no. of the drives as specified in the table above. Due to 
the fact that the 5th axis (A1) is not used, MD 20070: AXCONF_MACHAX_USED[4]=0 
must be parameterized. This will remove the axis from the configuration of the NC. 

8.9.1 Default settings of the axis machine data for feed axes 
The following machine data list summarizes all default data or their recommended settings 
with SINAMICS S120 drives connected. 
Once they have been set, the axes are ready to traverse, and only a fine adjustment 
(reference point approach, software limit switches, position controller optimization, speed 
feedforward control, lead error compensation,...) must be performed. For further details, see: 
/FB/ SINUMERIK 802D sl description of functions. 

 

 Note 
For feed axes, only parameter set 1 = index [0] is used. Index [1] ... [5] must only be 
parameterized when using the switch set of parameters function (see FB Chapter 3), G331 
"Rigid tapping" or G33 (see FB Chapter 11). In this section, the values must only be entered 
in index [0]. 
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Table 8-12 Default settings of the axis machine data for feed axes 

MD Name Default 
value 

Unit Remarks 

31030 LEADSCREW_PITCH 10 mm Leadscrew of the ballscrew 
 
31050 
31060 

 
DRIVE_AX_RATIO_DENOM 
DRIVE_AX_RATIO_NUMERA

 
1 
1 

 Load gear transmission ratio 
Revolutions of the ballscrew 
Motor revolutions 

32000 MAX_AX_VELO 10000 mm/min Maximum axis velocity 
32300 MAX_AX_ACCEL 1 m/s2 Maximum axis acceleration 
34200 ENC_REFP_MODE 1  1: Incremental encoder 

Motor order no: 1Fx6xxx-xxxxx-
xAxx 
0: EnDat encoder 
Motor order no: 1Fx6xxx-xxxxx-
xExx 

36200 AX_VELO_LIMIT 11500 mm/min Threshold value for velocity 
monitoring; setting rule:  
MD 36200 = 1.15 x MD 32000 

 
Example: 

 
 

 
The axis can now be traversed. The direction of movement can be reversed using MD 
32100: AX_MOTION_DIR = 1 or –1 (without influencing the control direction of the position 
control). 

8.9.2 Default settings of the axis machine data for the spindle 
With SINUMERIK 802D sl, the spindle is a subfunction of the entire axis functionality. The 
machine data of the spindle are therefore to be found amongst the axis machine data (MD 
35xxx). 
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For this reason, data must also be entered for a spindle; this data has already been 
described in conjunction with the start-up of feed axes. 
The following variants are offered for the spindle drive: 
• digital spindle drive (PROFIBUS) with spindle actual-value encoder integrated into the 

motor 
• digital spindle drive with motor encoder and directly mounted spindle actual-value 

encoder 
• analog spindle drive with directly mounted spindle actual-value encoder 
• Analog spindle without spindle actual-value encoder 

 

  Note 
For spindles without gearstage switching, only gear stage 1 = index [1] is taken into 
account; 
index [2] ... [5] must only be parameterized when using the "Switch gearstage" function 
(see /FB/ Chapter 5). 

 

Table 8-13 Default settings of the axis machine data for the spindle 

MD Name Default 
value 

Unit Remarks 

30200 NUM_ENCS 1  0: spindle without speed actual-
value encoder (AM mode = 
operation without encoder) 
1: spindle with speed actual-
value encoder integrated into the 
motor (1PH7 motor) 

 
31050 
31060 

 
DRIVE_AX_RATIO_DENOM[1] 
DRIVE_AX_RATIO_NUMERA[1]

 
1 
1 

 Load gear transmission ratio 
Load revolutions 
Motor revolutions 

35100 SPIND_VELO_LIMIT 10000 rpm Maximum spindle speed 
35130 GEAR_STEP_MAX_VELO_LIMI

T[1] 
500 rpm Max. speed in gear stage 1 

35200 GEAR_STEP_SPEEDCTRL_AC
CEL[1] 

30 rev/s2 Acceleration in the speed control 
mode 

digital spindle drive (PROFIBUS) with spindle actual-value encoder integrated into the motor 
Parameterize the machine data listed in the previous table. 
Example: 
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For the spindle, it can be necessary to adapt the following additional machine data. 

Table 8-14 Additional machine data 

MD Name Default 
value 

Unit Recommendation/remark 

34000 REFP_CAM_IS_ACTIVE 1  0: without reference point cam 
34060 REFP_MAX_MARKER_DIST 20 Degr. 720_ = two spindle revolutions 
34110 REFP_CYCLE_NR 1 ... 5  0: The spindle is not involved in 

channel-specific referencing. 
35300 SPIND_POSCTRL_VELO 500 rpm  
36000 STOP_LIMIT_COARSE 0,04 Degr. 0,4 
36010 STOP_LIMIT_FINE 0,01 Degr. 0,1 
36030 STANDSTILL_POS_TOL 0,2 Degr. 1 
36060 STANDSTILL_VELO_TOL 0,0139 rpm 1 (interface signal "Axis/spindle 

stopped"  
V390x0001.4) 

36400 CONTOUR_TOL 1 Degr. 3 

digital spindle drive with motor encoder and directly mounted spindle actual-value encoder (TTL) 
Operating a second measuring system requires the following machine data settings. 

Table 8-15 Machine data to be set 

MD Name Value Recommendation/remark 
30220 ENC_MODULE_NR[0] 3 Here you must enter a module number to 

which the measuring system is connected 
for the second measuring system (e.g. 
"3"). 

30230 ENC_INPUT_NR[0] 2 DRIVE-CLIQ_slot on the module to which 
the second measuring system has been 
connected 

32110 SENC_FEEDBACK_POL[0] -1 If necessary, swap the counting direction 
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Analog spindle with spindle actual-value encoder 
Hardware requirement: 
The MCPA module must be available. (see Chapter "Connecting an analog spindle") 

Table 8-16 Machine data settings for analog spindle 

Machine data Value Explanation 
MD30100 CTRLOUT_SEGMENT_NR 0 Addressing local segment (onboard) 
MD30110 CTRLOUT_MODULE_NR 1 Module No. 1 
MD30120 CTRLOUT_NR 1 Output No. 1 
MD30130 CTRLOUT_TYPE 1 real standard output 
MD30134 IS_UNIPOLAR_OUTPUT 0 0: bipolar; >0: Unipolar 
MD32250 RATED_OUTVAL 100 100% control (10 V) 
MD32260 RATED_VELO 3300 cause this speed 
MD30230 ENC_INPUT_NR 2 Input No. 2 (2nd encoder) 

Since the MCPA module does not have an encoder connection, it is only possible to use an 
encoder if it is available as a 2nd encoder of a SINAMICS axis. This 2nd encoder must be 
configured within SINAMICS in such a manner that it is contained in the message frame and 
is thus available to the controller. 

Analog spindle without spindle actual-value encoder 
For an analog spindle without encoder, the same machine data apply as for an analog 
spindle with directly mounted encoder, but MD 30240 must be set to zero. 

Unipolar spindle for SINUMERIK 802D sl 
MD 30134 = 1 Unidirectional D/A value type "1" 
MD 32100 = 1Positive assignment, no inversion 
MD 32100 = -1 Positive assignment, inversion 

 
Machine data Direction of spindle 

rotation 
Voltage Setpoint 

display 
VB38020004 

30134 = 1 32100 = 1 Spindle CW >0 - Bit 6 = 1 
  Spindle CCW >0 + Bit 7 = 1 
      
30134 = 1 32100 = -1 Spindle CW >0 - Bit 6 = 1 
  Spindle CCW >0 + Bit 7 = 1 

MD 30134 = 2 Unidirectional D/A value type "2" 
MD 32100 = 1Positive assignment, no inversion 
MD 32100 = -1 Positive assignment, inversion 

 
Machine data Direction of spindle 

rotation 
Voltage Setpoint 

display 
VB38020004 

30134 = 2 32100 = 1 Spindle CW >0 - Bit 6 = 1 
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Machine data Direction of spindle 
rotation 

Voltage Setpoint 
display 

VB38020004 

  Spindle CCW >0 + Bit 7 = 1 
      
30134 = 2 32100 = -1 Spindle CW >0 - Bit 6 = 1 
  Spindle CCW >0 + Bit 7 = 1 

Example: Configuration for 3 axes with an analog spindle 
Output of an analog setpoint for a spindle drive for connecting a third-party converter (e. g. 
MICROMASTER). With software release 01.01, connection is possible via the MCPA 
module. 
ALM; 1-axis module; 1-axis module; 1-axis module 

Table 8-17 Machine data for the example 

MD Name X Y Z SP Remarks 
30100 CTRLOUT_SEGMENT_NR 5 5 5 0 local bus segment for analog 
30110 CTRLOUT_MODULE_NR 2 3 1 1 Module order 
30120 CTRLOUT_NR 1 1 1 1 Setpoint output on drive 

module/module 
30130 CTRLOUT_TYPE 1 1 1 1 Output value of the setpoint 

values 
30134 IS_UNIPOLAR_OUTPUT 0 0 0 0 The setpoint output is unipolar
30200 NUM_ENCS 1 1 1 1 Number of encoders 
30220 ENC_MODULE_NR 2 3 1 3 Transport module (the SMC30 

module is connected to the 
axis module of the Y axis) 

30230 ENC_INPUT_NR 1 1 1 2 Input on the drive module 
(X202) 

30240 ENC_TYPE 4 1 1 1 Encoder kind 
32250 RATED_OUTVAL (spindle) 80 Rated output voltage 8 V at 

Umax/min 
32260 RATED_VELO (spindle) 3200 Rated motor speed at 8 V 

Thereafter, set the following machine data: 

Table 8-18 Additional machine data 

MD Name Default value Recommendation/remark 
11240[2] PROFIBUS_SDB_NUMBER 0  
13060[2] DRIVE_TELEGRAM_TYPE 116 Standard message frame type for 

Profibus–DP 

If the transport module is the 3rd axis (example: Y). 
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Table 8-19 Additional machine data 

MD Name Default 
value 

Unit Recommendation/remark 

34000 REFP_CAM_IS_ACTIVE 1  0: without reference point cam 
34060 REFP_MAX_MARKER_DIST 20 Degr. 720_ = two spindle revolutions 
34110 REFP_CYCLE_NR 1 ... 5  0: The spindle is not involved in 

channel-specific referencing. 
35300 SPIND_POSCTRL_VELO 500 rpm  
36000 STOP_LIMIT_COARSE 0,04 Degr. 0,4 
36010 STOP_LIMIT_FINE 0,01 Degr. 0,1 
36030 STANDSTILL_POS_TOL 0,2 Degr. 1 
36060 STANDSTILL_VELO_TOL 0,0139 rpm 1 (interface signal "Axis/spindle 

stopped"  
V390x0001.4) 

36400 CONTOUR_TOL 1 Degr. 3 

 

8.9.3 PLC-controlled axis 
Axes can be controlled via the PLC's NCK interface V380x3000 / V390x3000 (also see 
functional description of positioning axes P2). The following functions are supported: 
• Positioning axis 
• Indexing axis 

Prerequisites 
With the aid of the axial machine data MD 30460 MA_BASE_FUNCTION_MASK, one axis 
can be defined as a permanently assigned PLC axis. For this, the following values must be 
set: MD 30460 MA_BASE_FUNCTION_MASK=20H  
The axis is a permanently assigned PLC axis. The axis can, however, be jogged and 
referenced. The axis cannot be assigned to the NC program This property is displayed from 
the NCK to the PLC in the V390x0011.7 "PLC axis permanently assigned" signal. 
The axis number of the PLC axis (the standard case is 6) is to be entered subsequently at 
the parameterized NC axis. 
Example: Lathe with 2 axes and 1 spindle 

Table 8-20 Adapting the axis machine data 

Axis MD 20070 
X1 [0]=1 
Z1 [1]=2 
SP [2]=3 
PLC [3]=6 

 



Initial start-up  
8.9 Set the axis/spindle-specific machine data. 

 Operating Instructions 
102 Operating Instructions, 12/2006, 6FC5397-0CP10-2BA0 

 

 Note 
The PLC axis control is activated by the positive edge of the "Start" signal. The "Start" signal 
must remain in the logic "1" state until the PLC axis control has been acknowledged 
positively or negatively by "Position reached" = "1" or Error = "1". The signal "Positioning axis 
active" = "1" indicates that the PLC axis control is active and that the output signals are valid

 

Abort 
The PLC axis control cannot be aborted by means of parameter "Start", but only by means of 
the axial interface signals (e.g., delete distancetogo). The axial interface also returns status 
signals of the axis that may need to be evaluated (e.g., exact stop, traverse command). 

Axis disable 
With the axis disabled, an axis controlled via PLC axis control will not move. Only a 
simulated actual value is generated. (Behavior as with NC programming). 

Fault detection 
If a PLC axis control could not be executed, this is indicated by the signal error 
(V390x3000.1 or V390x3000.0) with 'logic 1'. The cause of the error is coded as an error 
number. 

Explanation of the signals 
All of the signals of the PLC axis control function are compiled in the following table. 

Table 8-21 PLC axis control signals 

Signal  Type Remarks 
Control signals PLC --> NCK 
V380x3000.7 Start Bool 0->1= Start spindle control from PLC 
V380x3002.0 Preparatory function, 

incremental (IC)) 
Bool 1 = IC 

V380x3002.1 Preparatory function, 
shortest path (DC) 

Bool 1 = DC 

V380x3002.2 Traversing dimension 
inch 

Bool 1 = positioning axis inch, i.e. not metric 

V380x3003.0 Preparatory function 
abs. neg. direction 
(ACN) 

Bool 1 = ACN 

V380x3003.1 Preparatory function 
abs. pos. direction 
(ACP) 

Bool 1 = ACP 

V380x3003.7 Indexing position Bool 1 = Indexing axis 
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Signal  Type Remarks 
Real Rotary axis: Degree 

linear axis: mm or inches 
VD380x3004 Item 

DWord Indexing axis: Indexing position 
VD380x3008 Feedrate  Real Rotary axis and spindle: RPM 

See under table containing info about FRate 
Feedback: NCK ->PLC 
V390x3000.0 Axis cannot be started Bool 1 = error  
V390x3000.1 Error during traversing Bool 1 = error  
V390x3000.6 Position reached Bool 1 = In position 
V390x3000.7 Positioning axes active Bool Positioning axis active, feedback valid 
VB390x3003 Error code Byte see Table 

Explanation: 
The signals IC, DC, ACP, ACN may only be alternately in effect or none. If no signal is set, 
the AC is in effect (Absolute Coordinate). 

Error messages 

Table 8-22 Error messages via NCK 

Errors that occur due to handling of the NCK. 
30 16#1e The axis/spindle has been transferred to the NC while still in motion 
50 16#32 permanently assigned PLC axis jogs or references 
60 16#3C Permanently assigned PLC axis channel status does not currently permit a 

start 
100 16#64 Corresponds to interrupt number 16830 
105 16#69 Corresponds to interrupt number 16770 
106 16#6a Corresponds to interrupt number 22052 
107 16#6b Corresponds to interrupt number 22051 
108 16#6c Corresponds to interrupt number 22050 
109 16#6d Corresponds to interrupt number 22055 
110 16#6e Velocity/speed is negative 
111 16#6f Setpoint speed is zero 
112 16#70 Invalid gear stage 
115 16#73 Programmed position has not been reached 
117 16#75 G96/G961 is not active in the NC 
118 16#76 G96/G961 is still active in the NC 
120 16#78 Not an indexing axis 
121 16#79 Indexing position error 
125 16#7d DC (shortest path) not possible 
126 16#7e Minus absolute value not possible 
127 16#7f Plus absolute value not possible 
130 16#82 Software limit switch Plus 
131 16#83 Software limit switch minus 
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132 16#84 Working area limitation plus 
133 16#85 Working area limitation minus 
135 16#8/ Corresponds to interrupt number 17501 
136 16#88 Corresponds to interrupt number 17503 
System or other serious interrupts 
200 16#c8 Corresponds to system interrupt number 450007 

The alarms are described in: /DG/ SINUMERIK 802D sl "Diagnostics Guide" 

Pulse diagram 
 

1 2 3 4 5 6 7  
Figure 8-8 Pulse diagram normal condition 

1. 1. Function activation via positive edge of Start 
2. Positioning axis active = 1 shows that the function is active and that the output signals are 

valid 
3. positive acknowledgement Position reached = 1 and positioning axis active = 1 
4. Reset function activation after receipt of acknowledgment 
5. Signal change via function 
6. 2. Function activation via positive edge of Start 
7. Positioning axis active = 1 shows that the function is active and that the output signals are 

valid 
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1 2 3 4 5 6 7  
Figure 8-9 Pulse diagram (fault scenario) 

1. 1. Function activation via positive edge of Start 
2. Positioning axis active = 1 shows that the function is active and that the output signals are 

valid 
3. negative acknowledgement Error = 1 and Positioning axis active = 1 
4. Reset function activation after receipt of acknowledgment 
5. Signal change via function 
6. 2. Function activation via positive edge of Start 
7. Positioning axis active = 1 shows that the function is active and that the output signals are 

valid 

8.9.4 Completion of the commissioning of the axes/spindle 
The general commissioning of the axes/spindle is completed. A fine optimization must still be 
carried out. 

8.10 Completing the commissioning 
After the start-up by the machine manufacturer has been completed, it is recommended to 
carry out a data backup prior to delivery to the end customer:  
1. Performing an internal data backup (at least protection level 3 required): 

– Select the <Save data >softkey in the System operating area. 
– The drive machine data is saved automatically after the commissioning with HMI. 

2. Carry out external data backup on customer CF card (see Chapter "Data backup and 
series commissioning") 

3. Resetting the access level: 
– Select the <Delete passw.> softkey. 
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Commissioning the drives using HMI 9
HMI functions are available for commissioning and displaying the current status of the 
SINAMICS drives. 

Operating sequence 
These can be found in the System operating area. 
 
The dialog box of the drive machine data is opened via the <Mach. Data> <Drive MD> 
softkeys.  
The current configuration and the statuses of the control and infeed unit and the drive units 
are displayed. 

 
Figure 9-1 Drive machine data 

With a set password (at least "user"), the <Sinamics COMMISSIONING> softkey appears, 
via which you can access the commissioning area. 
Pressing the <Sinamics COMMISSIONING> softkey opens the main screen "Commissioning 
the SINAMICS Components".  
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Figure 9-2 "SINAMICS Commissioning" main screen 

Select the corresponding step using the cursor keys. 
<Open> displays the selected area.  
 
<Back> returns to the previous display. 

 

 Note 
The execution of the individual steps must take place in the specified order, because, for 
example, the component overview cannot be created without a topology display. The basic 
prerequisite is the successful completion of the topology detection and confirmation. 

 

Loading SINAMICS firmware 
The SINAMICS firmware can be loaded for all components or only for individual 
components. If the "individual components" option is selected, the component number must 
be entered.  
After pressing the <Start> softkey, a running bar appears via which the operator can track 
the progress of the download. The note "Please wait, download in progress" appears. During 
the download, the control system must not switched off. 
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Figure 9-3 Loading SINAMICS firmware 

To activate, a new start up is required after completion (Power off/on). The <Back> softkey 
reappears.  

Load default settings for the drive (Parameter Reset) 
The operator is notified that all previous SINAMICS parameters are cleared upon 
confirmation. 
The parameter reset can be performed for all of the components or only for individual 
components. If the individual components option is selected, the component number must be 
entered.  

 
Figure 9-4 Loading the default settings for the drive 

The process is carried out using the <Start> softkey. Successful completion is indicated in 
the lower part of the window in the form of informational text. <Back> returns you to the 
selection menu. 

Detection and confirmation of the topology 
The actual topology of the device (p0098[0]) is read-out and automatically entered in the 
parameter of the setpoint topology of the device (p0099[0]). Then the start of the quick 
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commissioning of the SINAMICS takes place with the entry of the Profibus protocol in each 
drive object and the BICO wiring. When this has ended, the parameter p0978[x] is 
automatically adapted to the existing configuration. The configuration is saved. 

 
Figure 9-5 Quick start-up 

The currently running procedure is documented in the lower part of the window in the form of 
a short text.  
To activate the detected topology, a new start up is required after completion (Power off/on). 
The <Back> softkey reappears.  

Displaying the topology  

 
Figure 9-6 Topology Display 

During the read-in and preparation of the data, which takes some time, a running bar is 
displayed. For repeated call-up, the screen appears immediately. The evaluated data are 
retained until "Power Off". 
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Overview of components 
The component name, type, number and firmware version of all the components and the 
topology comparison stage are displayed in the component overview.  

 
Figure 9-7 Component overview 

After pressing the <Details> softkey, a window appears with further details on the selected 
components. 

 
Figure 9-8 further details on the components 
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Configuration of the infeed 

 
Figure 9-9 Configuration of the infeed 

The current values are displayed in the screen form. If the configuration is not yet completed, 
new values can be entered. The screen form is completed with <Save>. <Back> returns you 
to the selection menu. 

Configuration of the power sections and motors 

 
Figure 9-10 Configuration of the power sections and motors 

The current values of the respective components are displayed in the screen form and can 
be reassigned. The entries are saved using the <Save> softkey. Using <Drive+> and 
<Drive–>, you can switch between the individual power sections.  
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Figure 9-11 Motor data 

The <Motor data> softkey opens another window with motor data. 

9.1 Terminal assignment X20 / X21 

Table 9-1 Configuring the X20 clamp after SINAMICS commissioning using HMI 

Pin 
no. 

Function Assignment BICO source BICO sink Macro no. 

ON/OFF 1 Infeed Line Module with 
DRIVE-CLiQ Connection 

CU: r0722.0 Infeed p840 150001 1 Input 
0/1 edge 
required "Infeed Ready Signal" of Line Module 

without DRIVE-CLiQ connection 
SLM X21.1 Drive p864 150005 

2 Input "OFF3 – rapid stop"  
Function: 
braking with configurable OFF3 ramp 
(p1135, p1136, p1137) then pulse 
suppression and closing lock-out. 
The drive is stopped by prompts. 
The braking behavior can be 
separately set for each servo. 
Behavior similar to that of terminal 64.

CU: r0722.1 Each drive 
2. OFF3, p849 

150001 
150005 

3 Input SH/SBC 1 - Group1 
SINAMICS Safety Integrated (SH 
enable=p9601) 

CU: r0722.2 p9620 (all drives in the 
group) 

No 
preassignment

4 Input SH/SBC 1 - Group2 
SINAMICS Safety Integrated (SH 
enable=p9601) 

CU: r0722.3 p9620 (all drives in the 
group) 

No 
preassignment

5  Ground for pin 1 .. 4 
6  24 P  
7 Output SH/SBC 1 - Group1 

SINAMICS Safety Integrated (SH 
enable=p9601) 

CU: p0738 p9774 Bit 1 
BICO from CU after the 
first drive in the group 

No 
preassignment
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Pin 
no. 

Function Assignment BICO source BICO sink Macro no. 

8 Output SH/SBC 1 - Group2 
SINAMICS Safety Integrated (SH 
enable=p9601) 

CU: p0739 p9774 Bit 1 
BICO from CU after the 
first drive in the group 

No 
preassignment

9  Ground for pins 7, 8, 10, 11    
10 Input Bero 1 – zero mark substitute" CU: r0722.10 p495=1 -- 
11 Input Probe 1 Decentralized Measuring  

(check that MD13210 = 1!) 
CU: p0680[0] = 0 Every drive p488 

Index = encoder 1,2,3 = 
3 

-- 

12  Ground for pins 7, 8, 10, 11 

 

Table 9-2 Configuring the X21 clamp after SINAMICS commissioning using HMI 

Pin no. Function  Assignment BICO source BICO sink Macro no. 
1 Input Digital input $A_IN[1] CU: r0722.4 CU: p2082[0] 
2 Input Digital input $A_IN[2] CU: r0722.5 CU: p2082[1] 
3 Input Digital input $A_IN[3] CU: r0722.6 CU: p2082[2] 

Digital input $A_IN[4] CU: p2082[3] 

150001 
150005 

4 Input 
Line contactor, feedback signal 

CU: r0722.7 
LM : p0860 -- 

5  Ground for pin 1 .. 4 
6  24 P 

Infeed Operation (Line Module with 
DRIVE-CLiQ Connection) 

LM : r0863.0 150001 7 Output 

Digital output $A_OUT[4] CU: p2091.3 

CU: p0742 

150005 
Infeed and operational readiness if 
Line Module with DRIVE-CLiQ 
connection 

LM : r0899.0 150001 8 Output 

Digital output $A_OUT[3] CU: p2091.2 

CU: p0743 

150005 
9  Ground for pins 7, 8, 10, 11    

Digital output $A_OUT[2] CU: p2091.1 150001 / 
150005 

Output 

Line contactor control LM : r0863.1 

CU: p0744 

-- 
Bero 2 – zero mark substitute CU: r0722.14 Drive: p0495=5 -- 

10 

Input 
2. OFF 2 CU: r0722.14 Drive: p0845 -- 

Output Digital output $A_OUT[1] CU p2091.0 CU: p0745 150001 / 
150005 

11 

Input Probe 2 Decentralized Measuring 
(check that MD13210 = 1!) 

CU: p0680[1]=0
CU: p0728 Bit 
15=0 

each drive p489 
Index = encoder 1,2,3 = 6 

 

12  Ground for pins 7, 8, 10, 11 
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Selected status signals  
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Edit a drive project with STARTER 10
10.1 Change a drive project OFFLINE 

Prerequisites 
• Components of the drive unit are assembled, completely wired (DRIVE-CLiQ) 
• The commissioning via HMI has occurred (see Chapter "SINAMICS commissioning using 

HMI") 

Sequence 
To create a new project, proceed as follows: 
1. Start the STARTER commissioning tool by clicking on the STARTER symbol or by the 

menu item Start > Programs > STARTER > STARTER in the Windows Start menu. 
2. In the menu bar, select Project > new . The system displays the window Insert single 

drive. 

 
Figure 10-1 Inserting single drive 

3. Selecting the device type with device version 
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Figure 10-2 Device type with device version 

Confirm your selection with <OK>; it is displayed as follows. 

 
Figure 10-3 Displaying the selection 

1. Activating the online access 
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Figure 10-4 Selecting the online access 

The online connection can be established via 
– TCP/IP 
– PPI. 
The settings required are described in the point "Interface settings at the PC/PG". 

2. Establish the online connection by pressing "Connect to target system". 
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Figure 10-5 Online connection is established 

3. To load the project into the PG, you must click on the Load to PG ==> button. 
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Figure 10-6 Loading the project to the PG 

Now you can supplement/change the project OFFLINE. 
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10.1.1 Example: Commissioning a direct measuring system for a spindle 

Sequence 
1. In the project tree, select the drive to be changed and and open the configuration via 

double-click. 

 
Figure 10-7 Selecting the drive in the project tree 

2. Click on <Configure DDS...> 
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Figure 10-8 Configuration SINAMICS_IN_802D "Control structure" 

3. Confirm the configuration with <Continue>. This also applies to the configuration window 
– Power_unit 
– Motor 
– Motor holding brake. 
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Figure 10-9 Configuration "Power_unit" 
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Figure 10-10 Configuration "Motor" 
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Figure 10-11 Configuration "Motor holding brake" 

4. In the encoder configuration window, select the encoder data. 
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Figure 10-12 Configuration "Encoder" 

For this, click on <Encoder data>. In the subsequent window, select the encoder data 
(e.g. incremental rotary encoder). 
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Figure 10-13 Selection screen for encoder data 

Complete the entry with <OK>. As confirmation, the system generates the following 
screen. 



 Edit a drive project with STARTER 
 10.1 Change a drive project OFFLINE 

Operating Instructions 
Operating Instructions, 12/2006, 6FC5397-0CP10-2BA0 129 

 
Figure 10-14 Configuration of the encoder 

5. In the next step, you must select the message frame type. For this, press <Continue>. 
The system displays the following screen. 
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Figure 10-15 Setting the message frame type 

 

  Note 
For the SINUMERIK 802D sl (as of software release 1.1 for G/N or 1.2 for T/M), the 
message frame 116 is to be set. 

 

6. With <Continue>, you can reach the the screen of the BICO interconnection. 
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Figure 10-16 BICO interconnection 

You can close the screen with <Cancel>. Confirm the safety query with <Yes>. 

 
Figure 10-17 Safety query 

Thus, the commissioning of the 2nd encoder is completed. To check, activate the topology 
screen. 
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Figure 10-18 Displaying the topology 

The direct measuring system of the spindle (Servo_03_to_Geber_2) is connected to the 
infeed (A_INF_02...). 
1. After completing all steps required for the configuration, you must reload the project back 

into the control system. 
 

  Note 
The topology window must be closed prior to connecting to the control system. 

 

Establish a connection to the target system. 
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Figure 10-19 Online connection is established 

Click the <== Download button. The system automatically saves the drive data in the 
control system. Commissioning has been completed. 
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10.1.2 Interface settings on PG/PC 

PPI interface 
 

 
Figure 10-20 Setting up the PG/PC interface: Properties 

The system has determined all possible interfaces on your PC (e.g. Serial Cable  (PPI)). 
Select an interface via the Interface parameterization used list box; thereafter, click on the 
Properties button and adapt the baud rate to the settings in the 802D sl (default: 115.2 
kbit/s). 

TCP/IP interface 
The connection can be established via the TCP/IP protocol. To this end, connect the PC/PG 
to the CU directly using a X Crosslink patch cable or a standard patch cable via the 
corporate LAN. 
The following additional steps of operation are required here: 
• Use the mouse to select the drive unit in the Project Navigator. 
• Open the selection menu by clicking on the right mouse button. 
• Use "Target device online access" to load data into the interactive dialog box which is 

now displayed. 
Slot 25 and the IP address do not comply with the default configuration.  
In corporate networks, the IP address assigned by the administrator must be entered; 
with direct connection, the SINAMICS is assigned the fixed IP address 169.254.11.22 in 
802D. 
When establishing a connection via Crosslink, the IP address of the PC/PG 
(169.254.11.23) must be entered in the user-defined, alternative configuration. 
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• For corporate networks with DHCP server, the password for protection level 1 must be 
entered via HMI. Use System > Service display > Service control system > Service 
network  to change the DHCP entry to yes. 

 
Figure 10-21 Features of SINAMICS 

 
Figure 10-22 Connection properties 



Edit a drive project with STARTER  
10.2 Operating the STARTER control panel (motor rotating) 

 Operating Instructions 
136 Operating Instructions, 12/2006, 6FC5397-0CP10-2BA0 

 
Figure 10-23 Alternative configuration 

10.2 Operating the STARTER control panel (motor rotating) 
This chapter shows you how to start the motor using the control panel function in the 
STARTER commissioning tool. This includes:  
• Load the project into the drive unit. 
• Operate the control panel. 

Prerequisites 
The following prerequisites must be fulfilled to operate the control panel in STARTER: 
• The components as described above are assembled. 
• The drive unit is turned on as prescribed. 
• You have established a connection from the serial PPI interface of the control unit to a 

PC/PG with PPI interface. 
• A project has been created using the STARTER commissioning tool. 

10.2.1 Loading the project into the drive unit 
To load the project into the drive unit, proceed as follows: 
1. Open the project to be loaded using the menu Project > Open. 
2. To use the "control panel" function, you have to switch to ONLINE mode. To switch to the 

ONLINE mode, click the function key Connect to target system (as shown in Fig. 1-28). 
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Figure 10-24 Project navigator with SINAMICS_In_802D 

3. An ONLINE connection is established and an ONLINE/OFFLINE comparison is carried 
out. If any differences are found, these are displayed. 

 
Figure 10-25 ONLINE/OFFLINE comparison, loading into target system 

4. You changed the data OFFLINE and now have to load it to the target system. Click on 
the following buttons in sequence: 
– <-- Download in the "ONLINE/OFFLINE comparison" dialog box 
– When the system asks "Are you sure?", click Yes. The system now starts loading the 

data. 
– When the system informs you that the data was successfully loaded to the target 

system, click OK. 
– Click OK for "Load from RAM to ROM". 

5. Differences were detected during the ONLINE/OFFLINE comparison again. Click Load to 
PG -->. 
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Figure 10-26 ONLINE/OFFLINE comparison, loading into PG 

6. Load the new data from the drive unit to the PG. Click on the following buttons in 
sequence: 
– When the system asks "Are you sure?", click Yes. The system now starts loading the 

data. 
– When the system informs you that the data was successfully loaded into the PG, click 

OK. 
7. No further discrepancies are displayed in the ONLINE/OFFLINE comparison dialog box. 

Click Close (see screenshot below). 

 
Figure 10-27 ONLINE/OFFLINE comparison, closing 

 

  Note 
When loading the project, note the LEDs on the Control Unit. The Control Unit is ready for 
operation when the LED RDY is continuously lit (green). 

 

This completes the procedure for configuring the drive unit hardware.  



 Edit a drive project with STARTER 
 10.2 Operating the STARTER control panel (motor rotating) 

Operating Instructions 
Operating Instructions, 12/2006, 6FC5397-0CP10-2BA0 139 

10.2.2 Operating the control panel 
After you have established the connection to the target system and uploaded the project, a 
green connector symbol is displayed in the Project Navigator in front of the drive unit and the 
other components configured. This indicates that the project data in STARTER and the 
target system is consistent (see the following figure).  
The drive unit is now ready to operate. 

.

 
Figure 10-28 Control Panel 

The following steps are required to operate the control panel in the STARTER 
commissioning tool such that the motor rotates: 
1. Double-click control panel in the project navigator under Drive_1> Commissioning (see 

Fig. 1-32). 
The control panel is displayed in STARTER (see the following). You can use the drive 
control panel to control the drive directly via the PC/PG.  
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Figure 10-29 Assuming control priority 

2. Click Assume control priority to connect the control panel to the drive interface. 
Note the message that is then displayed in the Control priority dialog screen. This 
message is very important. (also see the following figure). 

 

 
 Danger 

Use control priority with care! 
This function is intended exclusively for start-up and diagnosis or within the framework of 
maintenance work.  
Make sure that the drive is in the "OFF" status and that no ON/OFF1 command has been 
issued either by the control word for sequence control or another signal source (e.g. 
BICO interconnection). 
Once control priority has been transferred to the PC, the BICO interconnections on bit 1 
to bit 6 of the control word are no longer active. 
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.

 
Figure 10-30 Passing on the control priority to the PC 

You can enter an application monitoring time, which is the time that elapses between two 
setpoints before the sign-of-life monitoring function on the drive responds (fault 1910). 
You can use the default monitoring time (e.g. 3000 ms). 
1. Since our example concerns commissioning, confirm this dialog box for assuming control 

priority by choosing OK. 

.

 
Figure 10-31 Diagnostic view 

2. To display, amongst other things, the status lamps for the control word bits, click 
Display/hide diagnostics view. 
The following table NO TAG lists the most important digital input signals of the control 
word for sequence control, which are required to set a motor to motion and which are 
issued via the control panel for the control unit (CU320 in 802D). 
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Table 10-1 Control word sequential control 

Signal (control 
panel) 

PROFIdrive  
bit no. in CTW 
sequence control

Meaning 

ON/OFF1 Bit 0 0 = OFF (OFF1), stop via ramp-function generator, followed by 
pulse block 
1 = ON, operating condition 

ON/OFF2 Bit 1 0 = Coast down (OFF2), pulse block, motor coasts to standstill 
1 = Do not coast down, operating condition 

ON/OFF3 Bit 2 0 = Rapid stop (OFF3)  
1 = No rapid stop, operating condition 

Pulse enable Bit 3 0 = Disable operation, pulse block 
1 = Enable operation, enable pulses 

Enable ramp– 
function 
generator 

Bit 4 0 = Set ramp-function generator to 0 
1 = Enable ramp-function generator 

Start/stop 
ramp– 
function 
generator 

Bit 5 0 = Freeze ramp-function generator, retain current output value 
1 = Restart ramp-function generator, follows the input value 

Setpoint 
enable 

Bit 6 1 = Enable setpoint 
0 = Inhibit setpoint and set to 0 

 
Figure 10-32 Enable 

1. Click the Enables field to set the commands for enabling the control word in the drive 
system. 

 
Figure 10-33 Incoming supply control priority 

2. Click Infeed control priority. The infeed (Active Line Module) is powered-up. 
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3. Before starting the motor by choosing Motor on (see following figure), you have to make 
the following settings: 
– Enter a speed setpoint (e.g. 50 revolutions per minute). 
– Use the slider to set the setpoint in %. Position your cursor on the slider, hold down 

the left mouse button, and set the speed to 0%. 
 

 
 Danger 

During commissioning, note the machine traversing range and take appropriate 
external measures (e.g. monitoring the limit switch).  

 

 
Figure 10-34 Control panel prior to "Drive on" 

4. Click the Drive on button. The ON/OFF1 enable is set and displayed on the control panel. 

 
Figure 10-35 motor is turning 

5. Move the slider for the speed slowly from 0 to 100%. 
The motor starts to rotate. 

6. When you click Stop, the motor stops. You can also trigger a fast stop by pressing the 
space bar. 
The following steps show you how to return control priority to terminate the connection to 
the drive: 
– Supply 
– Control unit 
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Figure 10-36 Incoming supply control priority 

7. Click Infeed control priority. 

 
Figure 10-37 Incoming supply control priority 

8. Click on the Return... button to terminate the connection to the drive unit. 

 
Figure 10-38 Return control priority 

9. Confirm the query Return control priority? with Yes  
Now you are in the STARTER commissioning tool project, as shown in the figure below. 
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Figure 10-39 Commissioning completed 
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Starting Up the PLC 11
11.1 Overview 

General information 
The PLC is intended to control machine-related functional sequences. It is realized as a 
software PLC. 
The user program - a PLC cycle - is always executed in the same order of sequence. 
• Refresh of the process image (inputs, user interface, timers) 
• Processing of communication requests (operator panel, PLC 802 programming tool, 

version 3.0 and higher) 
• Editing of the user program 
• Evaluation of alarms 
• Output of the process image (outputs, user interface) 
During the cycle, the PLC executes the user program from the first to the last operation. The 
user program accesses the hardware inputs/outputs only via the process image and not 
directly. The PLC refreshes the hardware I/Os at the beginning or end of program execution. 
Thus, these signals are stable over a whole PLC cycle. 
The user program can only be created using the PLC 802 Programming Tool, version 3.1 
and higher, with the S7-200 programming language using ladder diagram. Ladder diagram is 
a graphical programming language for representing electric circuit diagrams.  

 

 Note 
"PLC 802 Library" with a description, which can be installed from the toolbox CD is offered 
as the basis for the PLC user program. This library contains a subroutine library and a 
sample program for a milling machine. 
If the Stop and Reset buttons are not implemented as normally closed contacts, a break in 
the line cannot be detected. 
Monitoring can take place via software solutions, as shown in the example MCP_802D (SBR 
34) of the subroutine library. 
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11.2 Programming Tool PLC802 
The Programming Tool PLC 802 programming package provides a user-friendly environment 
for developing, editing, and observing the logic to control your applications. 

11.2.1 Selecting the target system 
In the Programming Tool PLC802, the CPU type can be selected as the preset. In the 
operation tree, the operations that cannot be used for the target system, are marked with a 
red X ( ).  
By presetting the CPU type, an error check of the program already takes place when the 
program is written.  

 

 Note 
If the CPU type is not preset when opening a new project, all of the operations, addresses 
and functions in the Programming Tool PLC802 are available and can be used in the 
program. No check occurs during the input. Errors in presetting the CPU type are only 
displayed after successful download and restart of the control system.  

 

Procedure 
• You are now in the Programming Tool PLC802. 
• Select the Target system > CPU type  from the menu or right click on Project name (CPU 

type) in the operation tree. 

 
Figure 11-1 Select the CPU type by clicking with the right mouse key 

• You select a target system from the list box. 
Example:  
Range and functional limitations of the latest firmware version of the 802Dsl TM plus are 
taken into consideration. In order to ensure that both the CPU type and the product 
version of the firmware are taken into consideration when the range checks are carried 
out, you can have the Programming Tool PLC802 read the CPU type information directly 
from the target system. For more information, refer to the Programming Tool PLC802 
online help.  

• Reading the removed CPU type using the Programming Tool PLC 802 
For a read-out of the CPU type and product version of the firmware, click on the button 

 in the "CPU-Type" dialog box. 
The CPU type and the firmware version are displayed in the list box.  
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11.2.2 Interface to PLC 
Independently of the installed hardware, the following options are available for the 
connection setup between the control system and the PG/PC: 
• Via RS232 cables 

The parameters that are preset in the Programming Tool PLC802 must be accepted. No 
further adaptation is required. 

• Optionally via a network (Ethernet) 
Communication settings must be adapted in the control system and in the PLC802 
programming tool. 

You can set up the communication or you can edit the communication settings at any time. 

Connection buildup via the RS232 port 
The RS232 (V24) port can be used for connecting between the control system and the 
PC/PG (Programming Tool PLC802). 
Activating the connection to the control system 
The connection is activated at the operator panel of the control system in the System 
operating area via the <PLC> <STEP 7 connect.> softkeys. <Connect. active> The active or 
inactive state is kept even after Power On (except power-up with the default data). An active 
connection is displayed by a symbol in the status bar. 
Communication settings in the Programming Tool PLC802 
To setup the PPI parameters in the PLC802 programming tool, proceed as follows: 
1. In the navigation bar, click on the communication symbol or select View > Communication 

from the menu. 

 
Figure 11-2 Communication settings 

2. Double click on the "Access point" symbol in the "Communication" window. 
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Figure 11-3 Setting the interface 

3. Check the PG/PC interface in use. For RS232 communication, the interface 802D(PPI) 
must be assigned to the PLC802 programming tool. 

4. Set the baud rate for the transmission rate, which the Programming Tool PLC802 will use 
to communicate. The 802D sl supports 9.6 kBaud, 19.2 kBaud, 38.4 kBaud, 57.6 kBaud 
and 115.2 kBaud. 

5. Open the "local connection" tab. 
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Figure 11-4 Opening the "Local connection" window 

6. In the "local connection" tab, specify the COM port to which the RS232 (V24) cable is 
connected. 

7. Click on "OK" to exit the "Set PG/PC interface" dialog box. 
8. On the right side of the "Communication" dialog box, click on the blue text "Double-click 

to refresh". 
 

 
Figure 11-5 Communications link 



Starting Up the PLC  
11.2 Programming Tool PLC802 

 Operating Instructions 
152 Operating Instructions, 12/2006, 6FC5397-0CP10-2BA0 

 

 Note 
The connection must be activated at the control system (System > PLC > Connect on). 

 

Connection buildup via Ethernet 
The PLC802 programming tool needs port 102 for Ethernet communication. 
Enabling a communication port on the control system 
Enabling is done on the operator panel of the control system in the System operating area 
via the softkeys <Service display> <Service control> <Service network> <Service firewall>. 
 
Communication settings in the Programming Tool PLC802 
Proceed as follows to setup the network connection: 
1. In the navigation bar, click on the communication symbol or select View > Communication 

from the menu. 
2. Double click on the "Access point" symbol in the "Communication" window. 

 

 
Figure 11-6 Ethernet communication settings 

3. Select the Ethernet card for your computer. 
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Figure 11-7 Network card settings 

1. In the "Set PG/PC interface" dialog box, select the "OK" button. 
2. In the "Communication parameter" dialog box, enter the IP address for the corresponding 

802Dsl control system. 
3. Double-click on the Refresh symbol to establish a connection to the specified IP address. 

– If the connection is established and the type of the target system can be successfully 
determined, the corresponding symbol of the target system is displayed in the 
"Communication" dialog box. 

– If the connection attempt fails, the IP address is displayed as "not available" in the 
"Communication" dialog box. 

– If the connection is established, but STEP 7 Micro/WIN cannot determine the type of 
target system, the IP address is displayed as "unknown". 

 

  Note 
The connection must be enabled at the control system (Port 102). 
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Figure 11-8 Network communication connection 

11.3 First commissioning of the PLC 
In the delivered condition of the SINUMERIK 802D sl, the user program only consists of a 
NOP statement (no operation) and is stored in permanent memory. A user program 
corresponding to the requirements of the machine must be created by the user himself. 

11.4 Commissioning modes of the PLC 

Table 11-1 Commissioning modes 

Selection Response 
PCU 

switch on menu 
(802D sl) 

PCU 
start up menu 

(802D sl) 

PT PLC802
(PC) 

PLC  
program 

preselection 

Program 
status 

Retentive 
data 

(supported) 

MD for the 
PLC in the 

user interface
 NCK Start Up *      
Normal powerup Normal powerup  User program 

*** 
Run Unchanged Accepting the 

active PLC MD
Power-up 
with default values 

Power-up 
with default values 

 User program 
***  

Run deleted Standard PLC 
MD 

Power-up 
with saved data 

Power-up 
with saved data 

 User program 
***  

Run saved 
data 

Saved PLC 
MD 

PLC - Stop 
after POWER ON 

 PLC stop 
possible in 
Run or Stop

Unchanged Stop Unchanged Accepting the 
active PLC MD

PLC clear all / 
Default PLC 
program 

  NOP user 
program 

Run deleted Standard PLC 
MD 
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Selection Response 
PCU 

switch on menu 
(802D sl) 

PCU 
start up menu 

(802D sl) 

PT PLC802
(PC) 

PLC  
program 

preselection 

Program 
status 

Retentive 
data 

(supported) 

MD for the 
PLC in the 

user interface
 PLC Start Up **      
 Cold restart Run (after 

Stop) 
User program 
*** 

Run Unchanged Accepting the 
active PLC MD

 Cold restart 
and debug mode 

 User program 
*** 

Stop Unchanged Accepting the 
active PLC MD

       
 CPU memory reset  User program 

*** 
Run deleted Accepting the 

active PLC MD
 CPU memory reset 

and debug mode 
 User program 

*** 
Stop deleted Accepting the 

active PLC MD

* Hardkey System / Softkey Start up / NC 
** Hardkey System / Softkey Start up / PLC 
*** loads from the permanent memory into RAM memory 

 
Via the debug mode, the PLC remains in PLC stop after the control system start up. All 
startup modes that are set via a softkey only become effective after the next control system 
start up. 
The Run mode activates the cyclic operation. 
In the Stop mode, the following actions are activated: 
• all HW outputs are disabled 
• Profibus–DP is inactive 
• no cyclical operation (active user program is not executed) 
• The process image is no longer refreshed (frozen) 
• EMERGENCY STOP active 
The user only has the capability of loading a corrected or new project into the control system 
in Stop mode. The user program only becomes active after the next start up of the control 
system or of Run mode. 
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11.5 PLC alarms 

11.5.1 Overview 
The control system displays a maximum of 8 PLC alarms (system alarms or user alarms).  
The PLC manages the alarm information per PLC cycle. It saves or deletes the alarms in the 
alarm list in chronological order based on the time of their occurrence. The first alarm in the 
list is always the last alarm that occurred. 
When there are more than 8 alarms, the first seven alarms that occurred and the last 
(chronologically) are displayed with the highest deletion priority.  

Alarm response and cancel criteria 
The PLC also manages the alarm responses. The alarm reactions are always in effect 
regardless of the number of active alarms. Depending on the type of alarm response, the 
PLC activates the necessary action.  
A cancel criterion must be defined for each alarm. By default, the PLC uses the cancel 
criterion SELF-CLEARING (see configuration of user alarms). 
The following are cancel criteria: 
• POWERONCLEAR: The alarm is canceled by turning off / turning on the control system 

(POWER ON). 
• CANCELCLEAR: The alarm is cancelled by pressing the Cancel key or Reset key 

(analog NCK - alarms). 
• SELF-CLEARING: The alarm is cleared by the no longer existent cause of the alarm. 

 
The clearing conditions have the following priority: 
• POWERON CLEAR - system alarms (highest priority) 
• CANCEL CLEAR - system alarms 
• SELF-CLEARING - system alarms 
• POWERON CLEAR - user alarms 
• CANCEL CLEAR - system alarms 
• SELF-CLEARING - user alarm (lowest priority) 
The responses that an alarm is supposed to trigger in the PLC are defined for each alarm. 
By default, the PLC uses the alarm response SHOWALARM. 
The following are alarm responses: 
• PLC - Stop : No further user programs are executed, Profibus DP inactive and disabling 

of the hardware outputs. 
• EMERGENCY STOP: The PLC reports the EMER STOP signal to the NCK after 

processing the user program in the user interface. 
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• Feed disable: The PLC reports the FEED DISABLE signal to the NCK after processing 
the user program in the user interface. 

• Read-in disable: The PLC reports the READ-IN DISABLE signal to the NCK after 
processing the user program in the user interface. 

• NC Start disable: The PLC reports the NC START DISABLE signal to the NCK after 
processing the user program in the user interface. 

• SHOWALARM : This alarm has no alarm response. 

11.5.2 General PLC alarms 

 

 Note 
see SINUMERIK 802D sl diagnostics guide 

 

11.5.3 User alarms 
The subareas (0, 1) are available to the user in the user interface '' 1600xxxx '' for defining a 
user alarm.  
• Subarea 0: 8 x 8 bits for setting the user alarms (0 ->1 edge) 

 byte 0 : Bit 0 => 1. user alarm " 700000 " 
 byte 1 : Bit 0 => 9. user alarm " 700008 " 
 byte 7 : Bit 7 => 64. user alarm " 700063 " 
A new user alarm is activated with the respective bit (subarea 0) with a 0/1 edge. 

• Subarea 1: Variables of the user alarms 
Subarea 1 is provided for additional user information. It can only be written or read as a 
double word.  

• Subarea 2: Alarm response 
 Byte 0 : Bit 0 => NC Start disable 
 Bit 1 => reading-in disable 
 Bit 2 => feed disable of all axes 
 Bit 3 => EMER STOP 
 Bit 4 => PLC STOP 
With the aid of subarea 2, the user can evaluate the active alarm responses. It is read-
only. 

The user must clear self-clearing user alarms by resetting the respective bit in subarea 0 (1 -
> 0 edge). 
For the other user alarms, the PLC clears the corresponding user alarms after detecting the 
corresponding clearing conditions. If the bit of the user alarm is still on, the alarm reappears. 
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Method of operation of a user alarm 
A user alarm has a higher priority than the corresponding signal in the user interface (e.g. 
NC Start disable, read-in disable and EMER stop). 
Example: 
MD 14516[0]: USER_DAT_PLC_ALARM = 8 
For the active alarm 700000, the alarm 3000 EMER Stop is also active although the interface 
signal V26000000.1=0 

Configuring user alarms 
A configuration byte exists for each alarm. The user alarms can be configured by the user in 
the machine data 14516: USER_DATA_PLC_ALARM. 
Default setting MD 14516[0...63]: 0 => SHOWALARM/SELF-CLEARING user alarm 
Setup of the configuration byte: 
• Bit0 - Bit5 : Alarm responses 
• Bit6 - Bit7 : Clearing criterion 
Alarm responses: Bit0 - Bit 5 = 0: Showalarm (default) 
 Bit0 = 1: NC Start disable 
 Bit1 = 1: Read-in disable 
 Bit2 = 1: Feed disable of all axes 
 Bit3 = 1: EMER Stop 
 Bit4 = 1: PLC Stop 
 Bit5 = reserved 
Cancel criteria: Bit6 + Bit7 = 0: SELF-CLEARING alarm (default) 
 Bit6 = 1 : CANCELCLEAR alarm 
 Bit7 = 1 : POWERONCLEAR alarm 
The user alarm response PLC-Stop always has the clearing condition POWER ON. 

Alarm texts 
The user has two options for defining his own alarm texts.  
• via hardkey System \ Softkey <PLC> <Process PLC Alarm txt> 
• via Toolbox: Editing and loading the alarm text file with the aid of the RCS802 tool 
If the user does not assign a user alarm text, only the alarm number is displayed. 
The % symbol in the alarm text designates an additional variable. The variable type 
represents the display form of the variable. 
These variable types are possible: 
• %D whole decimal numbers 
• % I whole decimal numbers 
• %U Decimal number without sign 
• %O whole octal number 
• %X whole hexadecimal number 
• %B binary representation of 32 bit value 
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• %F 4 byte floating point number 
Examples - user alarm texts (Note: The text after "//" is a comment and is not displayed.) 
• 700000 '' '' // only user alarm number 
• 700001 '' HW limit switch axis X +'' 
• 700002 '' %D '' // only variable as a whole decimal number 
• 700003 '' Alarm number with fixed alarm text and variable %X '' 
• 700004 '' %U Alarm number with variable and fixed alarm text '' 
• 700005 ''Monitoring of axis active : %U'' 

Display: 700005 ''Monitoring of axis active : 1 
 or 700005 monitoring of axis active : 3 

11.6 PLC Programming 

11.6.1 Overview 
The PLC user program is created with the aid of the PLC 802 programming tool.  
In the "SIMATIC S7-200 Automation System System Manual" documentation, you will find 
the handling instructions for an S7-200. The PLC 802 programming tool implements a subset 
of this documentation. 
The following must be observed as compared to the basic S7-200 MicroWin system: 
• It is only possible to program the user program in a ladder diagram. 
• Only a subset of the programming language for the S7-200 is supported. 
• The compilation of the user program is done offline on a PG/PC or automatically during 

the download into the control system. 
• The project can be loaded into the control system (download). 
• It is possible to load the project from the control system (download). 
• No indirect addressing of the data is possible. Therefore, there are no programming 

errors in this respect while the program is running. 
• The user must manage his data and process information by type. 

For all accesses to the data, the agreed data type must be consistently used. 
How Do I 
Information1 T-value memory size DInt (32 Bit) 
Information 2 Override memory size byte (8 Bit) 
User data 
memory double word MD0 DInt (Information 1) 
memory byte MB4 byte (Information 2) 

• Furthermore, the alignment of the data to certain memory addresses is dependent upon 
the type of data (alignment). The alignment is done to byte addresses, which can be 
divided by the byte length of the data type with no remainder. 
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BOOL and BYTE can begin at any byte address (0, 1, 2, 3, ...),  
WORD and INT must begin at an even byte address (0, 2, 4, 6, ...) and 
DWORD, DINT and REAL must begin at a byte address that is divisible by 4 (0, 4, 8, 12, 
...). 
How Do I 
Memory bit MB0.1,MB3.5 
memory byte MB0,MB1,MB2 
memory word MW0,MW2,MW4 
MW3, MW5 ... are not permitted 
memory double word MD0,MD4,MD8 
MD1,MD2,MD3, MD5 ... are not permitted 

Table 11-2 PLC data types permitted in the control system 

Data type Size Address 
alignment 

Range for logical 
Operations 

Range for arithmetical 
Operations 

BOOL 1 bit 1 0, 1 - 
BYTE 1 bytes 1 00 ... FF 0 ... +255 
WORD 2 bytes 2 0000 ... FFFF -32 768 ... + 32 767 
DWORD 
(Double 
Word) 

4 bytes 4 0000 0000 ... FFFF FFFF -2 147 483 648 ...  
+2 147 483 647 

REAL 4 bytes 4 - ±10-37... ±1038 

PLC project 
The PLC 802 programming tool always manages a project (combinational logic, symbols and 
comments). By downloading, it is possible to save all of the essential information of a project 
in the control system. By uploading, the information is transferred from the control system to 
the PC. 
The control system can save a maximum of 6,000 instructional commands (4,000 for 802D sl 
value) and 1,500 symbols. The needed PLC memory is influenced by the following 
components: 
• Number of statements 
• Number and length of the symbol names 
• Number and length of the comments 

S7-200 Ladder diagram 
The addresses and operations can be defined in the "International" display mode. In the 
ladder diagram, the user programs his program in networks. Each network corresponds to a 
logic that reflects a certain sequence. In a ladder diagram, contacts, coils and boxes are 
possible as basic elements. For the contacts, there are normally open and normally closed 
contacts. Each coil corresponds to a relay. A box reflects a certain function. A box can be 
activated using an enable bit.  
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11.6.2 Overview of commands 

Table 11-3 Operand identifier 

Operand identifier Description 
V data 
T Times 
C Meters 
I Image of digital inputs 
Q Image of digital outputs 
F Flag 
SM Special bit memory 
AC ACCU  
L Local data 

 

Table 11-4 Structure of V-range addresses (see user interface) 

Type ID (module 
no.) 

Range no. (channel 
and  

axis No.) 

Subarea Offset Addressing 

00 
(10-79) 

00 
(00-99) 

0 
(0-9) 

000 
(000-999) 

Symbolic  
(8-digit) 

 

Table 11-5 802D sl address ranges 

Access Storage method 802Dsl TM value 802Dsl TM plus  
802Dsl NG plus 

802Dsl TM pro  
802Dsl NG pro 
802Dsl CU pro 

V 14000000.0-
79999999.7 

14000000.0-
79999999.7  

14000000.0-
79999999.7  

I  0.0 – 26.7  0.0 – 26.7  0.0 – 26.7  
Q 0.0 – 17.7  0.0 – 17.7  0.0 – 17.7  
F 0.0 – 255.7  0.0 – 383.7  0.0 – 383.7  
SM 0.0 - 0.6  0.0 - 0.6  0.0 - 0.6  
T 0–15 (100ms) 

 16–39 (10ms) 
0–15 (100ms) 
 16–39 (10ms) 

0–15 (100ms) 
 16–63 (10ms) 

C 0 – 31  0 – 31  0 – 63  

Bit (Byte.bit)  

L  0.0 - 59.7  0.0 - 59.7  0.0 - 59.7  
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Access Storage method 802Dsl TM value 802Dsl TM plus  
802Dsl NG plus 

802Dsl TM pro  
802Dsl NG pro 
802Dsl CU pro 

VB  14000000- 
79999999 

14000000- 
79999999 

14000000- 
79999999 

IB  0 – 26  0 – 26  0 – 26  
QB  0 – 17  0 – 17  0 – 17  
MB  0 – 255  0 – 383  0 – 383  
SMB  0  0  0  
LB  0 – 59  0 – 59  0 – 59  

Byte  

AC  0 – 3  0 – 3  0 – 3  
VW 14000000- 

79999998 
14000000- 
79999998 

14000000- 
79999998 

IW  0 – 24  0 – 24  0 – 24  
QW  0 – 16  0 – 16  0 – 16  
MW  0 – 254  0 – 382  0 – 382  
T  0–15 (100ms) 16–

39 (10ms) 
0–15 (100ms) 16–
39 (10ms) 

0–15 (100ms) 16–
63 (10ms) 

C  0 – 31  0 – 31  0 – 63  
LW  0 – 58  0 – 58  0 – 58  

Word  

AC  0 – 3  0 – 3  0 – 3  
VD  14000000- 

79999994 
14000000- 
79999994 

14000000-
79999994  

ID  0 – 20  0 – 20  0 – 20  
QD  0 – 12  0 – 12  0 – 12  
MD  0 – 252  0 – 380  0 – 380  
LD  0 – 56  0 – 56  0 – 56  

Double word  

AC  0 – 3  0 – 3  0 – 3  

 

Table 11-6 Special Marker SM Bit Definition 

SM bits Description 
SM 0.0 Bit memory with defined ONE signal 
SM 0.1 Initial setting: first PLC cycle '1', subsequent cycles '0' 
SM 0.2 buffered data lost - only valid in first PLC cycle 

('0' data ok, '1' data lost) 
SM 0.3 POWER ON: first PLC cycle '1', subsequent cycles '0' 
SM 0.4 60 s clock (alternating '0' for 30 s, then '1' for 30 s) 
SM 0.5 1 s clock (alternating '0' for 0.5 s, then '1' for 0.5 s) 
SM 0.6 PLC cycle clock (alternating one cycle '0', then one cycle'1') 

 
The user can only view the statement list (STL) in the PT802 in "View STL". In this display 
method (see table: mnemonic), the sequential processing is displayed. 
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11.6.3 Explanation of the stack operations 

Table 11-7 BASIC BOOLEAN INSTRUCTIONS 

BASIC BOOLEAN INSTRUCTIONS 
Instruction Ladder Symbol Valid Operands 

Load 
And 
Or 

normal open 
n=1 close 
n=0 open 

 

 

n: V, I, Q, M, SM, T, C, L 

Load Not 
And Not 
Or Not 

normal close 
n=0 close 
n=1 open 

 

 

n: V, I, Q, M, SM, T, C, L 

Output prior 0, n=0 
prior 1, n=1   

n: V, I, Q, M,T, C, L 

Set 
(1 Bit) 

prior 0, not set 
prior 1 or ↗  

S_Bit: V, I, Q, M, T, C, L 
n = 1 

Reset 
(1 Bit) 

prior 0, no reset 
prior 1 or ↗  

S_Bit: V, I, Q, M, T, C, L 
n =1 

 

Table 11-8 OTHER BOOLEAN INSTRUCTIONS 

OTHER BOOLEAN INSTRUCTIONS 
Instruction Ladder Symbol Valid Operands 

Edge Up prior ↗ close 
(1 PLC cycle) 

 

 

 

Edge Down prior ↗ close 
(1 PLC cycle) 

 

 

 

Logical Not prior 0, later 1 
prior 1, later 0 

 

 

 

No operation   

 

n = 0 ... 255 

 

Table 11-9 BYTE COMPARES 

BYTE COMPARES (Unsigned) 
Instruction Ladder Symbol Valid Operands 

Load Byte = 
And Byte =  
Or Byte =  

a = b close 
a ≠ b open 

 

 

a : VB, IB, QB, MB, SMB, AC, Constant, LB 
b: VB, IB, QB, MB, SMB, AC, Constant, LB 



Starting Up the PLC  
11.6 PLC Programming 

 Operating Instructions 
164 Operating Instructions, 12/2006, 6FC5397-0CP10-2BA0 

BYTE COMPARES (Unsigned) 
Instruction Ladder Symbol Valid Operands 

Load Byte≥ 
And Byte ≥ 
Or Byte≥ 

a ≥ b close 
a < b open 

 

 
Load Byte ≤ 
And Byte ≤ 
Or Byte ≤ 

a ≤ b close 
a > b open 

 

 
Load Byte ≠  
And Byte ≠  
Or Byte ≠  

a ≠b close  
a = b open  

 
Load Byte > 
And Byte > 
Or Byte > 

a > b close 
a ≤b open 

 
Load Byte < 
And Byte <  
Or Byte <  

a < b close  
a ≥b open 

 

 

Table 11-10 WORD COMPARES 

WORD COMPARES (Signed) 
Instruction Ladder Symbol Valid Operands 

Load Word = 
And Word = 
Or Word =  

a = b close 
a ≠ b open 

 

 
Load Word≥ 
And Word≥ 
Or Word ≥ 

a ≥ b close 
a < b open 

 

 
Load Word ≤ 
And Word ≤ 
Or Word ≤ 

a ≤ b close 
a > b open 

 

 
Load Word ≠ 
And Word ≠  
Or Word ≠ 

a ≠b close  
a = b open  

 
Load Word > 
And Word >  
Or Word >  

a > b close 
a ≤b open 

 
Load Word <  
And Word <  
Or Word <  

a < b close  
a ≥b open 

 

a : VW, T, C, IW, QW, MW, AC, Constant, LW 
b: VW, T, C, IW, QW, MW, AC, Constant, LW 
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Table 11-11 DOUBLE WORD COMPARES 

DOUBLE WORD COMPARES (Signed) 
Instruction Ladder Symbol Valid Operands 

Load DWord = 
And DWord = 
Or DWord = 

a = b close 
a ≠ b open 

 

 
Load DWord≥ 
And DWord ≥ 
Or DWord ≥ 

a ≥ b close 
a < b open 

 

 
Load DWord ≤ 
And DWord ≤ 
Or DWord ≤ 

a ≤ b close 
a > b open 

 

 
Load DWord ≠ 
And DWord ≠ 
Or DWord ≠ 

a ≠b close  
a = b open  

 
Load DWord > 
And DWord > 
Or DWord > 

a > b close 
a ≤b open 

 
Load DWord < 
And DWord < 
Or DWord < 

a < b close  
a ≥b open 

 

a : VD, ID, QD, MD, AC, Constant, LB 
b: VD, ID, QD, MD, AC, Constant, LB 

 

Table 11-12 REAL WORD COMPARES 

REAL WORD COMPARES (Signed) 
Instruction Ladder Symbol Valid Operands 

Load RWord = 
And RWord = 
Or RWord = 

a = b close 
a ≠ b open 

 

 
Load RWord ≥ 
And RWord ≥ 
Or RWord ≥ 

a ≥ b close 
a < b open 

 

 
Load RWord ≤ 
And RWord ≤ 
Or RWord ≤ 

a ≤ b close 
a > b open 

 

 
Load RWord ≠ 
And RWord ≠ 
Or RWord ≠ 

a ≠b close  
a = b open  

 

a : VD, ID, QD, MD, AC, Constant, LD 
b: VD, ID, QD, MD, AC, Constant, LD 
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REAL WORD COMPARES (Signed) 
Instruction Ladder Symbol Valid Operands 

Load RWord > 
And RWord > 
Or RWord > 

a > b close 
a ≤b open 

 
Load RWord < 
And RWord < 
Or RWord < 

a < b close  
a ≥b open 

 

 

Table 11-13 TIMER 

TIMER 
Instruction Ladder Symbol Valid Operands 

Timer Retentive On 
Delay 

EN=1, Start  
EN=0, Stop 
If TValue ≥ PT,  
Tbit=1 

 

 

Enable : (IN) 
 S0  
Txxx: T0 - T63 (dependent on type of control 
system) 
Preset: (PT) 
 VW, T, C, IW, QW, MW, AC, Constant 
100 ms T0 - T15 
10 ms T16 - T63 

Timer On Delay EN=1, Start  
EN=0, Stop 
If TValue ≥ PT,  
Tbit=1 

 

 

Enable : (IN) 
 S0  
Txxx: T0 - T63 
Preset: (PT) 
 VW, T, C, IW, QW, MW, AC, Constant 
100 ms T0 - T15 
10 ms T16 - T63 

Timer Of Delay If TValue < PT,  
Tbit=1 

 

 

Enable : (IN) 
 S0  
Txxx: T0 - T63 
Preset: (PT) 
 VW, T, C, IW, QW, MW, AC, Constant 
100 ms T0 - T15 
10 ms T16 - T63 

 

Table 11-14 COUNTER 

COUNTER 
Instruction Ladder Symbol Valid Operands 

Count Up CU ↗, Value+1 
R=1, Reset 
If CValue ≥ PV,  
Cbit=1 

 

 

Cnt Up: (CU) 
 S1 
Reset: (R) 
 S0  
Cxxx: C0 - 63 
Preset: (PV) 
 VW, T, C, IW, QW, MW, AC, Constant, LW 
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COUNTER 
Instruction Ladder Symbol Valid Operands 

Count Up/Down CU ↗, Value+1 
CD ↗, Value-1 
R=1, Reset 
If CValue ≥ PV,  
Cbit=1 

 

 

Cnt Up: (CU) 
 S2 
Cnt Dn: (CD) 
 S1 
Reset: (R) 
 S0  
Cxxx: C0 - 63 
Preset: (PV) 
 VW, T, C, IW, QW, MW, AC, Constant, LW 

Count Down If CValue = 0, 
Cbit=1 

 

 

Cnt Down: (CD) 
 S2 
Reset: (R) 
 S0  
Cxxx: C0 - 63 
Preset: (PV) 
 VW, T, C, IW, QW, MW, AC, Constant, LW 

 

Table 11-15 MATH OPERATIONS 

MATH OPERATIONS 
Instruction Ladder Symbol Valid Operands 

Word Add 
Word Subtract 

If EN = 1, 
b = a + b 
b = b - a 

 

Enable : EN 
In: VW, T, C, IW, QW, MW, AC, Constant, LW 
Out: VW, T, C, IW, QW, MW, AC, LW 

DWord Add 
DWord Subtract 

If EN = 1, 
b = a + b 
b = b - a 

 

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 

Multiply  If EN = 1, 
b = a x b 

 

Enable : EN 
In: VW, T, C, IW, QW, MW, AC, Constant, LW 
Out: VD, ID, QD, MD, AC, LD 

Divide If EN = 1,  
b = b ÷ a 
Out:  
16 bit remainder 
Out+2:  
16 bit quotient 

 

Enable : EN 
In: VW, T, C, IW, QW, MW, AC, Constant, LW 
Out: VD, ID, QD, MD, LD 

Add  
Subtract  
Real Numbers 

If EN = 1, 
b = a + b 
b = b - a 

 

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 
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MATH OPERATIONS 
Instruction Ladder Symbol Valid Operands 

Multiply  
Divide 
Real Numbers 

If EN = 1,  
b = a x b 
b = b ÷ a 

 

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 

Square Root If EN = 1, 
OUT = √IN 

 

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 

 

Table 11-16 INCREMENT, DECREMENT 

INCREMENT, DECREMENT 
Instruction Ladder Symbol Valid Operands 

Increment  
Decrement 
Byte 

If EN = 1, 
a = a + 1 
a = a -1 

 

Enable : EN 
In: VB, IB, QB, MB, AC, Constant LB 
Out: VB, IB, QB, MB, AC, LB  

Increment  
Decrement  
Word 

If EN = 1, 
a = a + 1 
a = a -1 
a = /a  

Enable : EN 
In: VW, T, C, IW, QW, MW, AC, Constant, LW 
Out: VW, T, C, IW, QW, MW, AC, LW 

Increment 
Decrement. 

If EN = 1, 
a = a + 1 
a = a -1 

 

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 

 

Table 11-17 LOGIC OPERATIONS 

LOGIC OPERATIONS 
Instruction Ladder Symbol Valid Operands 

Byte AND 
Byte OR 
Byte XOR 

If EN = 1, 
b = a AND b 
b = a OR b 
b = a XOR b  

Enable : EN 
In: VB, IB, QB, MB, AC, Constant, LB 
Out: VB, IB, QB, MB, AC, LB  

Word AND 
Word OR 
Word XOR 

If EN = 1, 
b = a AND b 
b = a OR b 
b = a XOR b  

Enable : EN 
In: VW, T, C, IW, QW, MW, AC, Constant, LW 
Out: VW, T, C, IW, QW, MW, AC, LW 

DWord AND 
DWord OR 
DWord XOR 

If EN = 1, 
b = a AND b 
b = a OR b 
b = a XOR b  

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 
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LOGIC OPERATIONS 
Instruction Ladder Symbol Valid Operands 

Invert Byte If EN = 1, 
a = /a 

 

Enable : EN 
In: VB, IB, QB, MB, AC, Constant, LB 
Out: VB, IB, QB, MB, AC, LB  

Invert Word If EN = 1, 
a = /a 

 

Enable : EN 
In: VW, T, C, IW, QW, MW, AC, Constant, LW 
Out: VW, T, C, IW, QW, MW, AC, LW 

Invert DWord If EN = 1, 
a = /a 

 

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 

 

Table 11-18 SHIFT AND ROTATE OPERATIONS 

SHIFT AND ROTATE OPERATIONS 
Instruction Ladder Symbol Valid Operands 

Shift Right  
Shift Left 

If EN = 1, 
a = a SR c bits 
a = a SL c bits 

 

 

Enable : EN 
In: VB, IB, QB, MB, AC, Constant, LB 
Out: VB, IB, QB, MB, AC 
Count: VB, IB, QB, MB, AC, Constant, LB 

Shift Right  
Shift Left 

If EN = 1, 
a = a SR c bits 
a = a SL c bits 

 

 

Enable : EN 
In: VW, T, C, IW, QW, MW, AC, Constant, LW 
Out: VW, T, C, IW, QW, MW, AC, LW 
Count: VB, IB, QB, MB,AC, Constant, LB 

DWord Shift R  
DWord Shift L 

If EN = 1, 
a = a SR c bits 
a = a SL c bits 

 

 

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 
Count: VB, IB, QB, MB, AC, Constant, LB 

 

Table 11-19 CONVERSION OPERATIONS 

CONVERSION OPERATIONS 
Instruction Ladder Symbol Valid Operands 

Convert Double 
Word Integer to a 
Real  

If EN = 1, convert the 
double word integer i 
to a real number o. 

 

 

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 
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CONVERSION OPERATIONS 
Instruction Ladder Symbol Valid Operands 

Convert a Real to a 
Double Word Integer 

If EN = 1, convert the 
real number i to a 
double word integer 
o. 

 

 

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 

Convert BCD to 
Binary 

If EN = 1, convert the 
BCD value IN to a 
binary value OUT 

 

Enable : EN 
In: VW, T, C, IW, QW, MW, AC, Constant, LW 
Out: VW, T, C, IW, QW, MW, AC, LW 

Convert Binary to 
BCD 

If EN = 1, convert the 
binary value IN to a 
BCD value OUT 

 

Enable : EN 
In: VW, T, C, IW, QW, MW, AC, Constant, LW 
Out: VW, T, C, IW, QW, MW, AC, LW 

 

Table 11-20 PROGRAM CONTROL FUNCTIONS 

PROGRAM CONTROL FUNCTIONS 
Instruction Ladder Symbol Valid Operands 

Jump to Label If EN = 1, go to label 
n. 

 

Enable : EN 
Label: WORD: 0-127 

Label Label marker for the 
jump.   

Label: WORD: 0-127 

Conditional Return 
from Subroutine 

If EN = 1, exit the 
subroutine. 

 

 

Enable : EN 

Return from 
Subroutine 

Exit subroutine. 
 

 

Conditional End If EN = 1, END 
terminates the main 
scan. 

 

 

Enable : EN 

Subroutine If EN ↗, go to 
subroutine n. 

Label: Constant : 0-63 
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Table 11-21 MOVE, FILL AND FIND OPERATIONS 

MOVE, FILL AND FIND OPERATIONS 
Instruction Ladder Symbol Valid Operands 

Move Byte If EN = 1,  
copy i to o. 

 

 

Enable : EN 
In: VB, IB, QB, MB, AC, Constant, LB 
Out: VB, IB, QB, MB, AC, LB  

Move Word If EN = 1,  
copy i to o. 

 

 

Enable : EN 
In: VW, T, C, IW, QW, MW, AC, Constant, LW 
Out: VW, T, C, IW, QW, MW, AC, LW 

Move DWord If EN = 1,  
copy i to o. 

 

 

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 

Move Real If EN = 1,  
copy i to o. 

 

 

Enable : EN 
In: VD, ID, QD, MD, AC, Constant, LD 
Out: VD, ID, QD, MD, AC, LD 

Swap Bytes If EN = 1,  
exchange MSB and 
LSB of w. 

 

 

Enable : EN 
In: VW, IW, QW, MW, T, C, AC, LW 

 

11.6.4 Program organization 
Each programmer should structure his user program into finished program parts 
(subroutines). The programming language for S7-200 offers the user the capability to set up 
his user program in a structured manner. There are two types of programs, the main 
program and the subroutine. Eight levels of programming are possible.  
A PLC cycle can be a simple cycle of the control system-internal interpolation cycle (IPO 
cycle). The machine manufacturer must set the PLC cycle according to the specific 
requirements (see machine data "PLC_IPO_TIME_RATIO"). The IPO/ PLC ratio of 1:1 is the 
fastest possible cyclical processing. 
How Do I The programmer writes a sequential control in his main program with the aid of a 
user-defined cycle counter. This organizes all of the cyclical signals in the subroutine (UP0), 
UP1/UP2 are called up every two cycles and UP3 controls all of the signals in the grid of 
three cycles. 
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11.6.5 Data management 
The data can be broken down into three areas: 
• non-retentive data 
• retentive data 
• Machine data for the PLC (These machine data are all POWER ON active.) 
The majority of the data, such as the process image, timer and counter are not retentive data 
and they are cleared each time the control system is powered up. 
For the retentive data there is a data range of 1400 0000 -1400 0127. The user can store all 
data there, which is to remain valid beyond POWER OFF/ON. 
With the aid of the PLC-MD (see user interface), the user can pre-assign his program with 
data or he can parameterize various parts of the program. 

11.6.6 Testing and monitoring your program 
Checking or performing an error analysis of the user program can be done using: 
• PLC Status: Displaying and changing called up operands 
• Status list: Displaying and changing three freely selectable variable boxes 
• PLC Program: Displaying and monitoring (status) of the entire user program, including 

symbols and comments 
• Programming Tool PLC802: Connecting a PG/PC and activating the programming tool. 

11.7 PLC application Download/Upload/Copy/Compare 
The user can save, copy or over-write the PLC project or the PLC applications in the control 
system. 
This is possible using: 
• Programming Tool PLC802 
• RCS802 
• CF card 
The PLC project contains the PLC user program, including all of the important information 
(symbols, comments, ...). The programming tool performs uploads and downloads into the 
control system. The PLC project can also be imported and exported by the programming tool 
in "*.pte" format. In this format (*.pte), the project can also be read-in/out using the RCS802 
tool or directly at the control system of the CF card. 
The PLC user alarm texts can be created using the RCS802 tool or the alarm text editor on 
the control system. 
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PLC user alarm texts

PLC project

PLC project

 
Figure 11-9 PLC applications in the control system 

 

Download 
This function writes the transferred data into the permanent memory (load memory) of the 
control system. 
• Download PLC project using the PLC802 programming tool 
• Series commissioning (operating area System <COMMISIONING Files> <802D Data> 

"commissioning archive (NC/PLC)") using the RCS802 tool or the CF card.  
For example, for the CF card: 
At this point, the commissioning archive of the customer CF card must be copied and 
pasted into the commissioning files directory > commissioning archive (NC/PLC). 
– NC data 
– NC directories 
– Display machine data 
– Leadscrew error compensation data (LEC) 
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– PLC user program 
– PLC user alarm texts 
– Drive machine data 

• Read-in PLC project with the RCS802 tool or CF card 
• Read-in PLC user alarm texts with the RCS802 tool or CF card 
• Transfer the PLC user alarm texts from the toolbox project using the RCS802 tool. 

Upload 
The PLC project can be saved from the permanent memory of the control system using the 
PLC802 programming tool or the RCS802 tool or the CF card. 
• Upload PLC project using the PLC802 programming tool 
• Series commissioning (operating area System <COMMISIONING Files> <802D Data> 

"commissioning archive (NC/PLC)") using the RCS802 tool (PLC machine data, PLC 
project and user alarm texts) or the CF card 
Note: PLC machine data is part of the general machine data. 

• Read-out PLC project with the RCS802 tool or copy to a CF card 
• Read-out PLC user alarm texts with the RCS802 tool or CF card 

Compare 
The project in the PLC802 programming tool is compared to the project in the permanent 
memory (load memory) in the control system. 

Version display 
Call-up via hardkey SYSTEM Softkey <Service Display> <Version> 
• PLC Application 

The transferred project that is active in the working memory of the PLC after a control 
system start up. 
In the PLC802 programming tool, in the comments of the properties of OB1, the 
programmer can use the beginning of the first line of comments for his own additional 
information in the version display. 
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11.8 User interface 
This interface encompasses all of the signals between the NCK/PLC and the HMI/PLC. In 
addition, the PLC decodes the auxiliary functions commands for simple further processing in 
the user program. 
 

 

 Note 
See /FB/ SINUMERIK 802D sl "Description of Functions", Chapter 20 
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Data Backup and Series Machine Start-Up 12
12.1 Data Backup 

12.1.1 Internal data backup 
The data of the limited-buffered memory must be saved via a backup copy to the permanent 
memory of the control system. This backup is performed internally and is always necessary if 
the control system is switched off for longer than 60 hours.  
The buffer time depends on various factors and can reach a value of at least 8 days under 
normal circumstances (25°C ambient temperature). 
Recommendation: After changing important data, it is recommended to carry out a data 
backup immediately. 

 

 Note 
During the data backup, an image of the limited-buffered memory is produced and stored in 
the permanent memory. A backup of selected data (e.g. only machine data and no 
workpiece programs) is not possible. 

 

Performing an internal data backup 
Select the Save data softkey in the System operating area (at least protection level 3 
required). Press <OK> to confirm the notes which now appear. 

 

 Note 
While the internal data backup is running, the control system must neither be operated, nor 
be turned off. 
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Loading internally backed-up data 
• Boot the control system in the commissioning mode "Reload saved user data". 
• In case of data loss of the buffered memory, the data saved in the permanent memory 

are automatically reloaded into the memory with POWER ON. 
 

  Note 
Message "4062 Data backup copy has been loaded" is displayed on the screen. 

 

12.1.2 External data backup 
In addition to an internal data backup, the user data of the control system can also be saved 
externally. To do so, a PC with V24 interface or Ethernet and the RCS802 tool (included in 
the toolbox) or a CF card are required.  
An external data backup should be performed if major data changes have been made or 
always at the end of the commissioning.  
To create a complete data backup for a machine, it is sufficient to create the series machine 
start-up file. 

Variants of external data backup 
1. Reading out the data completely: Series start-up 
2. Files are read out / read in for each area individually. The following user data can be 

selected from the "System" operating area as individual files: 
Data in the text format 
– All machine data 
– Setting data 
– Tool data 
– R parameters 
– Zero point offset 
– Compensation data (LEC) 
– Global user data 
Start-up archive (NC/PLC) 
– NC data 
– NC directories 
– Display machine data 
– Compensation data (LEC) 
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– PLC user alarm texts 
– PLC project (cannot be edited with PT 802) 
– Drive machine data 
Start-up archive (HMI) 
– User cycles 
– Customer directories 
– Language file SP1 
– Language file SP2 
– start screen 
– Online help 
– HMI bitmaps 
– Tool geometry database 
– Startup data 
PLC project (PT802D*.PTE) 

3. Furthermore, the following data can be saved from the "Program Manager" operating 
area: 
– Machine-manufacturer cycles 
– Siemens cycles 
– User cycles 
– Main programs 
– Subroutines 

12.1.3 Data backup via the RS232/Ethernet interface 

 

 Note 
Never connect or disconnect the RS232 cable when the PCU is connected to the mains.  
Make sure that the settings of the RS232 interface of the 802D and of the COM port on the 
PC are identical. 

 

Creating a start-up archive in the PC (data transfer from the control system to the PC) 
(See Chapter "Series commissioning") 
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Data backup in the 802D data area (text format) 
One single file will result, which contains the data you have selected for backup. 

 

 Note 
/BP/ SINUMERIK 802D sl "Operation and Programming", Chapter "Data Backup" 

 

Data backup in the "Program Manager" operating area 
The system outputs in text format the data from the Program Manager <NC directory>  
operating area. 

 

 Note 
/BP/ SINUMERIK 802D sl "Operation and Programming", Chapter "Data Backup" 

 

 

12.1.4 External data backup via CF Card 
On the CF card, the same data can be saved as those which are saved via the serial 
interface. The selection of the data to be backed up is the same as (<System> 
<COMMISSIONING files> <802D Data> <Copy>), saving to the card is down via <Customer 
CF Card> and <Insert>. 

12.1.5 Data backup in case of backlight failure 
In case of failure of the backlight of the control system, menu-assisted operation is no longer 
possible. If backlight failure occurs at the control system, you can use a key combination to 
carry out external data backup on a CF card.  
To do so, the CF card must be inserted. 
After power-on and booting of the control system, indicated by LEDs on the CNC control 
panel (RDY and NC), press <CTRL + S>. 
This will output the series machine start-up archives (NC/PLC and HMI) with the latest 
current data. 
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12.2 Series commissioning 

Functionality 
The objective of the series machine start-up is: 
• to bring another control system at a machine of the same type to the same condition as 

after a commissioning 
or 

• to bring a new control system to the initial state in case of servicing (after hardware 
replacement) with the least expenditure. 

Start-up archive (NC/PLC) 
The start-up archive (NC/PLC) incorporates the following selectable data: 
• Drive machine data 
• NC data 
• NC directories 
• Display machine data 
• Compensation data (LEC) 
• PLC user alarms 
• PLC project 

Start-up archive (HMI) 
The start-up archive (HMI) incorporates the following data: 
• User cycles 
• Customer directory 
• Language file SP1 
• Language file SP2 
• start screen 
• Online help 
• HMI bitmaps 
• Tool geometry database 
• Startup data 

Prerequisites 
The prerequisite for the series machine start-up is a PC with V24 interface or Ethernet 
interface for data transfer from/to the control system, or a CF card. 
In the PC, the RCS802 tool must be used.  
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Sequence with PC (RCS802) 
1. Creating a start-up archive (NC/PLC) in the PC (data transfer from the control system to 

the PC): 
– Establish a connection between the PC (RCS802) and the control system. The control 

system requires the password for protection level 2. 
– In the directory tree of the RCS802, open Control 802 > 802D Data (A:), activate the 

Start-up archive (NC/PLC) directory and click on Copy via the context menu (right 
mouse button). 

– In the directory tree, select the target directory and insert the commissioning archive 
by clicking on Paste via the context menu. 

2. Reading in the series start-up file from the PC into the control system 
– Establish a connection between the PC (RCS802) and the control system. The control 

system requires the password for protection level 2. 
– In the directory tree of RCS802, select the commissioning archive to be transferred 

and click on Copy via the context menu (right mouse button). 
– In the directory tree of the RCS802, open Control 802 > 802D Data (A:), activate the 

Start-up archive (NC/PLC) directory and click on Paste via the context menu (right 
mouse button). 

– The series commissioning then commences. A warm start of the NC/PLC is performed 
several times. At the end of the series machine start-up, the whole control system will 
reboot (warm start). After an error-free series machine start-up, the control system will 
be in a fully configured operating condition. 

 

  Note 
Start-up archive (HMI) 
This data backup is created analogously to the start-up archive (NC/PLC). For 
creating and reading, you must activate the Start-up archive (HMI) directory instead of 
the Start-up archive (NC/PLC) directory in the directory tree of the RCS802. 

 

Sequence with CF card 
1. Creating a series machine start-up file on the CF card: 

– Make sure that the CF card is inserted in the slot on the device front panel. 
– The control system requires the password for protection level 2. 
– Under the menu <System> <COMMISSIONING Files> <802D Data> select the line 

"Commissioning Archive (NC/PLC)" and copy it to the clipboard using <Copy> . Select 
the <Customer CF card> softkey to display the contents of the inserted card. If you 
select the <Paste> softkey and subsequently enter the name for the archive file, the 
series commissioning is produced on the card. 

2. Reading in the series start-up file from the CF card into the SINUMERIK 802D sl 
– Make sure that the CF card is inserted. 
– The control system requires the password for protection level 2. 
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– Under the System > <COMMISSIONING Files > < Customer CF card menu, select the 
line containing the desired archive and use Copy to paste the data to the clipboard. 
Select the <802D data> softkey and select the "Commissioning archive (NC/PLC)" 
line. Selecting the <Paste> softkey will transmit the series commissioning to the 
control system. 

– Once reading-in has started, confirm the start of the series commissioning in the 
control system in the screen that appears. 

– A warm start of the NC/PLC is performed several times during the series machine 
start-up. At the end of the series machine start-up, the whole control system will 
reboot (warm start). After an error-free series machine start-up, the control system will 
be in a fully configured operating condition. 
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Technical data 13
User data memory 

Compact Flash Card, type 1 (CF Card)  

Connected loads of the PCU 

Table 13-1 Connected loads 

Supply voltage 24 V DC (permissible range: 20.4...28.8 V) 
Ripple 3.6 Vpp 
Current consumption from 24 V Basic configuration 

typically 1.5 A (inputs/outputs open) 
Power loss 
• CNC operator panel (PCU) with NC full 

keyboard 
• Machine control panel 
• PP72/48 I/O module 

max. 50 W 
 
≤ 5 W 
max. 11 W  

Starting current, total 5 A 

Dimensions and weight 

Table 13-2 Dimensions and weight 

CNC operator panel (PCU)  
Dimensions W × H × D (mm) 310 x 330 x 85 

310 x 330 x 101 with MCPA module 
Weight [g] approx. 4,900 
NC full keyboard (upright design) 
Dimensions W × H × D (mm) 310   175   32 
Weight [g] approx. 1,700 
NC full keyboard (vertical design) 
Dimensions W × H × D (mm) 172 x 330 x 32 
Weight [g] approx. 1,700 
Machine control panel 
Dimensions W × H × D (mm) 170 x 330 x 128 
Weight [g] approx. 1,500 
PP72/48 I/O module 
Dimensions W × H × D (mm) 194 x 325 x 35 
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Weight [g] 
• without mounting plate 
• with mounting plate 

 
• approx. 300 
• approx. 1,200 

MCPA module 
Dimensions W × H × D (mm) 89 x 205 x 68 
Weight [g] approx. 300 

Digital inputs of the PP72/48 I/O module (as per IEC 1131-2 / DIN EN 61131-2, type 2 characteristic) 

Table 13-3 Digital inputs of the PP72/48 I/O module 

Number of inputs 24 each per terminal strip converter 
parameters min. Standard Maximum Nominal 
Voltage with high level (UH) 15 V 1) 30 V 24 V 
Input current IIn at UH 2 mA - 15 mA - 
Voltage with low level (UL) -30 V - 5 V 0 V 
Signal delay time TPHL 2) 0.5 ms - 3 ms - 
1) Supply voltage of the digital inputs 
typical output voltage: VCC - IOUT * RON 
VCC: current operating voltage (P24OUTINT) to X111, X222, X333: Pin 2 
2)In addition, take into account the PROFIBUS–DP communication time and the application cycle 
time. 
Polarity reversal causes neither high level nor destruction of the inputs. 

Digital outputs of the PP72/48 (as per IEC 1131-2 / DIN EN 61131-2) 

Table 13-4 Digital outputs of the PP72/48 I/O module 

Number of outputs 16 each per terminal strip converter 
 
parameters 

 
min. 

 
Standard 

 
Maximum 

 
Nominal 

Voltage with high level (UH) VCC - 3 V 1) VCC 24 V 
 Iout  - - 0.25 A - 
Voltage with low level (UL) - - - Output 

open 
Leakage current at low level - 50 µA 400 µA - 
Signal delay time TPHL 2) - - 0.5 ms - 
max. switching frequency 2) 
• resistive load 
• inductive load 
• Lamp 

100 Hz 
2 Hz 
11 Hz 

- 
- 
- 

- 
- 
- 

- 
- 
- 
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Number of outputs 16 each per terminal strip converter 
1) Supply voltage of the digital outputs 
typical output voltage: VCC - IOUT * RON 
VCC: Current operating voltage 
Max. output current IOUT: 0.25 A  
max. short-circuit current: 4 A (max. 100 µs, VCC = 24 V) 
Inner flow resistance RON: 0.4 Ω 
2)In addition, take into account the PROFIBUS–DP communication time and the application cycle 
time. 
Incorrect connection causes neither high level nor destruction of the outputs. 

General electric features: 
• Galvanic isolation using optocouplers 
• Current limited to max. 0.25 A 
• Protection against: 

– short-circuit 
– Overtemperature 
– loss of grounding 

• Automatic disconnection in case of undervoltage 

13.1 Electro-Magnetic Compatibility 

Definition 
Electromagnetic compatibility refers to the capability of electrical equipment in reliably 
performing its dedicated function in an electromagnetic environment, without causing 
interference in the same environment.  

Emission of Radio Interferences 

Table 13-5 Interference emission of electromagnetic fields as per EN 55011: Limit value class A, 
group 1. 

between 20 and 230 MHz <30 dB (µV/m) Q 
between 230 and 1000 MHz <37 dB (µV/m) Q 
measured at a distance of 30 m 

 

Table 13-6 Interference emission via network alternating current supply in accordance with EN 
55011: Limit value class A, group 1. 

between 0.15 and 0.5 MHz <79 dB (µV) Q 
<66 dB (µV) M 
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between 0.5 and 5 MHz <73 dB (µV) Q 
<60 dB (µV) M 

between 5 and 30 MHz <73 dB (µV) Q 
<60 dB (µV) M 

Extension of the range of application 
If you intend to use the control system in residential areas, you must ensure that the control 
system meets the requirements of limit value class B to EN 55011 in respect of interference 
emission. 
Recommendation: Install the control system in grounded metal cabinets, such as 8MC 
cabinets (see NV 21 Catalog). Connect filters to the supply lines. 

13.2 Transport and storage conditions 
The following data applies to modules that are transported or stored in the original 
packaging.  

Table 13-7 Shipping and storage conditions 

Type of condition Permissible range 
Free fall ≤ 1m 
Temperature -20°C to +60°C 
Atmospheric pressure 1,060 ... 700 hPa (corresponds to an altitude of 3,000) 
Relative humidity 5% to 95%, without condensation 

 

13.3 Ambient operating conditions for the operation 

Conditions of use 
The control system is intended for use as a stationary equipment in a sheltered environment. 
The conditions of use are compliant with requirements to DIN IEC 68–2–2:  
The control system satisfies the operating conditions of the 3C3 class in accordance with 
DIN EN 607213-3 (operating locations with high traffic densities and in the immediate vicinity 
of industrial plants with chemical emissions). 
The control system must not be operated without additional measures being taken 
• in locations with a high proportion of ionizing radiation 
• Locations with severe operating conditions, e.g. due to: 

– dust 
– caustic vapor or gases. 
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• in plants which require special supervision, e.g. 
– Elevator systems 
– electrical equipment in especially hazardous rooms. 

An additional measure for use of the control system may be, for example, the installation in 
cabinets. 

Climatic environmental conditions 
The control system can be used under the following climatic ambient conditions: 

Table 13-8 Climatic environmental conditions 

Environmental conditions Fields of application Remarks 
Temperature 0 to 50 °C with a simultaneity of 50 % 
Relative humidity from 5% to 95 % Without condensation, 

corresponds to relative humidity 
(RH) severity level 2 in 
accordance with IEC 1131-2 

Atmospheric pressure from 1,080 to 795 hPa - 
Concentration of pollutants SO2: <0.5 ppm; 

Relative humidity <60 %, 
no condensation 
H2S: <0.1 ppm; 
Relative humidity <60 %, 
no condensation 

Test: 
10 ppm; 4 days 
1 ppm; 4 days 

Mechanical ambient conditions 
The mechanical ambient conditions for the control system are specified in the table below in 
the form of sinusoidal waves. 

Table 13-9 Mechanical ambient conditions 

Mechanical ambient conditions Operation Transport (in packaging) 
Vibration tested as per  
DIN EN 60068-2-68 

10..0.58 Hz: 0.35 mm 
58 to 200 Hz: 50 m/s2 

5...9 Hz: 3.5 mm 
9 to 200 Hz: 10 m/s2 

Shock resistance tested in accordance 
with  
DIN EN 60068–2–27 

10 g peak value, 6 ms 
duration 
100 shocks in each of the 
3 axes vertical to one 
another 

10 g peak value, 6 ms duration 
100 shocks in each of the 3 axes 
vertical to one another 

Reduction of vibration 
If the control system is subjected to major impacts or vibration, appropriate measures must 
be taken to reduce the acceleration or the amplitude of the vibration. 
We recommend mounting the control system on shock-absorbing material (e.g. vibration-
absorbing metal). 
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13.4 Specifications for Protection Class and Degree of Protection 

Protection class 
Safety class I as per DIN EN 61140, i.e. protective conductor connection required! 

Protection against ingress of solid foreign bodies and water 
Degree of protection per DIN EN 60529: 
• CNC operator panel (PCU) IP65 (front) 

 IP00 (rear) 
• Machine control panel (MCP) IP54 (front) 

 IP00 (rear) 
• PP 72/48 I/O module IP00 
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Dimensional Drawings 14
14.1 CNC operator panel (PCU) dimension drawing and hole drilling 

template 
 

 Note 
Dimensions marked with 1) are minimum clearances to adjacent modules. 
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Figure 14-1 CNC operator panel (PCU) dimensional drawing  
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Figure 14-2 Dimensional drawing CNC operator panel with MCPA module 
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Figure 14-3 CNC operator panel (PCU) hole drilling template  

 



 Dimensional Drawings 
 14.2 Dimensions and hole drilling template of the machine control panel (MCP) 
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14.2 Dimensions and hole drilling template of the machine control panel 
(MCP) 
  

Figure 14-4 Dimension and hole drilling template of the machine control panel MCP 
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Figure 14-5 Dimension and hole drilling template of the machine control panel MCP 802D sl 



 Dimensional Drawings 
 14.3 NC full keyboard dimension and hole drilling templates 
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14.3 NC full keyboard dimension and hole drilling templates 

Dimensional drawing and hole drilling template of the NC full keyboard (installed next to the PCU) 

 

 
Figure 14-6 Dimensional drawing and hole drilling template of the NC full keyboard (installed next to the PCU) 
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Dimensional drawing and hole drilling template of the NC full keyboard (installed under the PCU) 

 
Figure 14-7 Dimensional drawing and hole drilling template of the NC full keyboard (installed under the PCU) 
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 14.4 PP72/48 peripheral module dimension drawing 
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14.4 PP72/48 peripheral module dimension drawing 

 
Figure 14-8 PP72/-48 peripheral module dimensional drawing 
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14.5 Dimensional drawing MCPA module 

 
Figure 14-9 Dimensional drawing MCPA module 
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ESD guidelines A
A.1 What does ESD mean? 

Definition 
All electronic modules are equipped with highly integrated modules or components. Based 
on their design, these electronic components are highly sensitive to overvoltage and thus to 
discharge of static electricity. 
These Electrostatic Sensitive Devices/Modules are commonly abbreviated ESD. The 
common international designation ESD stands for Electrostatic Sensitive Device. 
Electrostatic sensitive modules are identified by the following symbol: 

 
 

 
 

 
Caution 
Electrostatic sensitive devices may be destroyed by voltages that are undetectable to a 
human. Voltages of this kind occur as soon as a component or an assembly is touched by a 
person who is not grounded against static electricity. The damage to a module as a result of 
overvoltage cannot usually be detected immediately. It may only become apparent after a 
long period of operation. 

 

A.2 Electrostatic Discharge to Persons 

Charge 
Anyone who is not connected to the electrical potential of their surroundings can be 
electrostatically charged. 
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Figure NO TAGE indicates the maximum electrostatic voltages that can accumulate in a 
person who is operating equipment when he/she comes into contact with the materials 
shown in the figure. These values correspond with specifications to IEC 801–2. 

 
Figure A-1 Electrostatic Voltages which can Build up on a Person 

 

A.3 Basic protective measures against discharge of static electricity 

Make sure the grounding is good 
When working with electrostatically sensitive devices, make sure that the person, the 
workstation and the packaging are properly grounded. This helps you avoid static charge. 

Avoid direct contact 
Electrostatically sensitive devices should only be touched if this cannot be avoided (e.g. 
when performing maintenance work). When you touch modules, make sure that you do not 
touch either the pins on the modules or the printed conductors. This prevents any discharge 
of static electricity to sensitive component and thus avoids damage. 
Discharge your body before beginning work on a module. To do so, touch a grounded 
metallic object. Use only grounded measuring and test equipment. 
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List of abbreviations B
B.1 Abbreviations 802D sl 
 
Abbreviation German English 
AC Alternating Current Alternating current 
ALM Active line module Active line module 
BERO Tradename for a type of proximity switch Tradename for a type of proximity switch 
BICO Binector Connector Technology Binector Connector Technology 
CBC Communication Board CAN Communication Board CAN 
CBE Communication Board Ethernet Communication Board Ethernet 
CPU Central processing unit Central processing unit 
CNC Computer Numerical Control Computer Numerical Control 
CSM Control Supply Modules Control Supply Modules 
CU Control Unit Control Unit 
DC Direct current Direct Current 
DO Drive object Drive Object 
DP Distributed I/O Decentralized Peripherals 
DRIVE-CLiQ Drive Component Link with IQ Drive Component Link with IQ 
EP Pulse enable Enable Pulses 
EMC Electro-Magnetic Compatibility Electromagnetic Compatibility (EMC) 
EN European Standard European Standard 
FI Residual Current Circuit Breaker Earth Leakage Circuit Breaker (ELCB) 
HMI Man-machine interface Human Machine Interface 
IEC International Electrotechnical Commission International Electrotechnical Commission 
IT Insulated three-phase supply network Insulated three-phase supply network 
LED Light-emitting diode Light Emitting Diode 
LM Line Module Line Module 
NC Numerical Control Numerical Control 
NCK NC kernel with block preparation, traversing 

range, etc. 
Numerical Control Kernel 

NCU Numerical Control Unit Numerical Control Unit 
NX Numerical Extension Numerical Extension 
OP Operator panel front Operator Panel 
PCU CNC integrated into the operator panel for 

user interface, system software and soft PLC
Panel Control Unit 

PI Protective earth Protective Earth 
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Abbreviation German English 
PELV Safety Extra-Low Voltage Safety Extra-Low Voltage 
PLC Programmable Logical Controller Programmable Logic Controller 
SBC Safe Brake Control Safe Brake Control 
SH Safe stop Safe standstill 
SIL Safety Integrity Level Safety Integrity Level 
SLM Smart line modules Smart line modules 
SMC Sensor Module Cabinet Sensor Module Cabinet 
SME Sensor Module External Sensor Module External 
SPL Safe Programmable Logic Safe Programmable Logic 
STW Control word Control word 
TCU Thin Client Unit Thin Client Unit 
TM Terminal Module Terminal Module 
TN Grounded three-phase supply network Grounded three-phase supply network 
TT Grounded three-phase supply network Grounded three-phase supply network 
VPM Voltage Protection Module Voltage Protection Module 
VS Power supply Voltage Supply 
VSM Voltage Sensing Module Voltage Sensing Module 
ZSW Status Word Status word 
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Index 

Ａ 
Access levels, 70 
Analog output 

Assignment, 31 
Analog spindle 

Connecting, 53 

Ｂ 
BERO, 64 
Bus connector 

setting the terminating resistor, 59 
wiring, 59 

Ｃ 
CNC full keyboard (installed next to the PCU) 

Dimensional drawing, 197 
CNC full keyboard (installed under the PCU) 

Dimensional drawing, 198 
CNC operator panel (PCU) 

Dimensional drawing, 192 
Hole drilling template, 194 

COM interface connection, 57 
Commissioning modes of the PLC, 154 
Compact flash card (CF card) slot, 19, 21 
Conditions of use, 188 
Connected loads, 185 
Connecting, 43 
Connecting the digital inputs/outputs, 64 

at the I/O module, 64 
to the CNC operator panel, 64 

Connecting the machine control, 65 
Connecting the SINAMICS S drive, 63 
Connection cables, 64 
Connection for the CNC full keyboard, 57 
Connection for the CNC full keyboard, 19 
Connection Overview, 51 
Control panel, 136 
Control Panel, 139 
Control word CTW1, 142 

Ｄ 
Data Backup 

external, 178 
in case of backlight failure, 180 
Internal, 177 

Data management, 172 
Description, 17 
Description of the PP 72/48 I/O module 

Operating elements, 35 
Detailed view, 72 
Diagnosis via STARTER, 74 
Diagnostics function, 74 

Function generator, 75 
Trace, 78 

Digital inputs, 25 
Assignment, 26, 30, 36 
Description, 28, 36 
Technical data, 186 

Digital inputs/digital outputs (PCU), 19 
digital outputs, 25 

Assignment, 26, 36 
Description, 28 

Digital outputs 
Assignment, 30 
Description, 36 
Technical data, 186 

Dimensional drawings, 192, 197, 198 
Dimensions, 185 
Drill patterns, 194 
DRIVE-CLiQ interface, 19, 24 

Ｅ 
Electrical design 

Configuration, 44 
Electro-Magnetic Compatibility, 187 
EMC Directives, 43 
EMERGENCY STOP concept, 43 
Entering the machine data, 88 
Environmental conditions, 188 

Mechanical, 189 
Error displays, 67 
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Ethernet interface, 19, 21 
Ethernet interface connection, 57 

Ｆ 
Function Generator 

Features, 76 

Ｇ 
Generator for signals, 75 

Ｈ 
Handwheel connection, 19, 24 

Ｉ 
I/O device interface, 35, 36 
Illustration of the CNC operator panel (PCU) 

interfaces, 18 
Installation, 47 
Interface for MCPA module, 19 

Ｌ 
Language setting, 82 
Layout 

electrical:configuration, 44 

Ｍ 
Machine control, 65 
Machine control panel (MCP 802D sl), 196 
Machine control panel (MCP), 195 
MCPA module, 28 
Measuring probe, 64 
Modules 

Shipping and storage conditions, 188 
Motor turning, 136 
Mounting 

the shield connection, 65 

Ｏ 
Operator control and display elements, 67 
Operator interface, 72 

Ｐ 
PCU interfaces, 18 

Compact flash card (CF card) slot, 21 
Digital inputs/outputs, 25 
Ethernet interface, 21 
Handwheel connection, 24 
PROFIBUS DP interface, 23 
RS232 COM interface, 22 

Peripheral (I/O) module connection, 58 
Place shielded cables, 65 
PLC alarms, 156 
PLC command overview, 161 
PLC Programming, 159 
Power supply connection, 19, 35, 55 
PP 72/48 interfaces, 35 

I/O device interface, 36 
Product Overview, 13 
PROFIBUS address, 90 
PROFIBUS DP connection, 58 
PROFIBUS DP interface, 35 
PROFIBUS DP1 interface, 19 
PROFIBUS interface, 23 
Program organization, 171 
Project navigator, 72 
Protection levels, 70 
Protective conductor, 50 

Ｒ 
Radio Interference 

Emission of, 187 
RCS tool, 71 
Recorder, 78 
RS232 COM interface, 22 
RS232 COM port, 19 

Ｓ 
Safety regulations, 43 

EMERGENCY OFF equipment, 43 
Setpoint/actual value assignment, 93 
Setting the technology, 86 
Shield connection, 65 
Signal recording with the trace function, 75 
STARTER commissioning tool, 72 
Start-up 

Axis/spindle, 93 
Exit, 105 
PLC, 147 
Series startup, 181 

Status displays, 67 
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Ｔ 
technical data, 185 
Technical data 

Digital inputs, 186 
Digital outputs, 186 

Terminal strip converter, 36 
Terminating resistor 

Adjusting to bus connector, 59 
Trace, 78 
Trace function 

Signal recording, 75 

Ｕ 
USB interface, 19 

User alarms, 157 
Using the STARTER control panel, 136 

Ｖ 
Vibration, 189 

Ｗ 
Weight, 185 
wiring 

Bus connector, 59 
Work Area, 72 
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